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ABSTRACT
The aim of this collaborative project between Massachusetts Institute of Technology (MIT) and
Cyprus Institute was to develop an experimental procedure for identifying fresh submarine groundwater
discharge (SGD) in Cyprus. SGD is a flow of water from coastal aquifers into the ocean driven by a
hydraulic gradient and other forces. Understanding SGD is crucial for informed groundwater
management. In some cases, SGD creates submarine springs which can be tapped to provide
supplementary freshwater. This is particularly enticing for countries such as Cyprus, where energy- and
cost-intensive desalination plants are necessary to meet freshwater demand.
A preliminary protocol for locating SGD was developed based on a review of literature and
interviews with experts. The protocol was tailored to suit resources available in Cyprus. Because
groundwater temperature typically deviates from ocean water, an infrared camera mounted on a manned
aircraft was used to obtain an ocean surface temperature map. Areas exhibiting temperature anomalies
were revisited by boat to measure salinity in situ using a conductivity, temperature and depth sensor
(CTD). This protocol was tested in Chrysochou Bay, selected based on relatively high estimates of SGD
from published water mass balances as well as recommendations from local fishermen.
The designed method proved effective; areas of anomalous salinities and temperatures were found.
However the protocol can be improved based on experience gained through this study. Manned aircrafts
are unfit for a large-scale study due to high costs, flight restrictions, and lack of appropriate navigational
equipment on accessible vehicles. Unmanned aerial vehicles are more suitable for a full-scale study.
Additionally, obtaining a salinity profile by a series of point measurements, as with the CTD, is timeconsuming. A towed resistivity array would provide similar salinity profiles in a fraction of the time.
A thorough investigation of SGD is planned in Cyprus in the spring, when SGD is highest. This
paper presents a recommended procedure for the spring investigation based on the results of this study.

Thesis Supervisor:

Chryssostomos Chryssostomidis

Title:

Doherty Professor of Ocean Science and Engineering, Director of Sea
Grant College Program

4

ACKNOWLEDGEMENTS
The author would like to first and foremost thank her advisor, Prof. Chryssostomos
Chryssostomidis, for his continuous support and advice throughout this investigation, as well as
for providing her with this amazing opportunity, and Prof. David Marks for his encouragement.
A special thanks also to Prof. Harold Hemond and Prof. Franz Hover from the Massachusetts
Institute of Technology as well as to Dr. Matthew Charette from Woods Hole Oceanographic
Institute, all of whom were consulted on some aspect of the project. She is also grateful for
everyone in the Sea Grant College Program for being so helpful and welcoming over the past
year and to her wonderful friends and family for everything.
Additional thanks go to everyone at the Cyprus Institute, particularly Dr. Costas
Papanicolas, Dr. Manfred Lange, Dr. Leonard Barrie, Dr. Adriana Bruggeman, Dr. Nick
Polydorides, Dr. Cecelia Hannides, Ms. Eroulla Cadd, and especially Dr. Stelios Ioannou and Dr.
Christos Keleshis for their daily assistance and hospitality. Thank you also to the pilots, Mr.
Marios Argyrides and Mr. Constantinos Savvides, and the boat captain, Mr. Pavlos Hadjiantonis.
None of this research would have been possible without the financial support of the Cyprus
Program at MIT through the Cyprus Research Promotion Foundation, the MIT Sea Grant
College Program under NOAA Grant NA100AR417, and the MIT Energy Initiative. Thank you
all so much for your kindness and generosity.

6

Table of Contents
1.

Introduction ......................................................................................................................

2. Background........................................................................................................................

9
10

2.1 Subm arine Groundwater Discharge.........................................................................
2.2 SGD as an Exploitable Source of Freshwater...........................................................

10

2.3 M ethods of Identifying and M easuring Freshwater SGD .........................................
2.3.1 Hydrogeological Calculations ..........................................................................

12

2.3.2 Aerial Therm al Im aging ...................................................................................

14

2.3.2.1 InfraredThermography .................................................................................

14

2.3.3 Salinity..................................................................................................................

15

2.3.4 Geochem ical Tracers ........................................................................................

16

2.3.5 Lee-Type Seepage M eters .................................................................................
2.3.6 Other Observable Signs of SGD .........................................................................

16

2.4 Subm arine Groundwater Discharge in Cyprus ........................................................
2.5 Proposed Procedure for Cyprus ...............................................................................

18

3. Testing in Quonochontaug Pond, RI .............................................................................
3.1 Salinity Profiling .......................................................................................................

12
12

17
20
21
22

3.1.1 Conductivity, Tem perature and Depth Sensor..................................................
3.1.2 Determ ination of M easurem ent Locations ........................................................

22

3.1.3 Point M easurem ents of Salinity and Temperature...........................................
3.2 Quonochontaug Pond Results and Discussion ........................................................

25

24
26

4. Testing in Cyprus...............................................................................................................

27

4.1 Procedure .....................................................................................................................

28

3.1.1 Salinity M easurem ents.......................................................................................

28

4.1.2 Aerial Im aging ..................................................................................................

29

4.1.2.1 Infrared Video Camera..................................................................................

29

4.1.2.2 Cloud Cap Technology Gim bal ......................................................................

31

4.1.2.3 Relating InfraredImages to TemperatureDifferences ..................................
4.1.2.5 Aerial Imaging Procedure.............................................................................

33
36

4.1.2.6 Video Post-ProcessingProcedure..................................................................
4.2 Results and Discussion .............................................................................................

37

4.2.1 Salinity..................................................................................................................

37

4.2.2 Therm al Im aging ...............................................................................................

40

4.2.3 Discussion and Recom m endations ........................................................................

46

37

5. C on clusion s........................................................................................................................

48

Referen ces..............................................................................................................................
Appendix A. Using Google Earth to Find Waypoints........................................................

50

Appendix B. Using MATLAB to Create Profiles from YSI Castaway TM - CTD .............
Appendix C. MATLAB Functions for YSI CastAwayTM - CTD Data Analysis................

55

Appendix D: Salinity Measurements from Quonochontaug Pond ..................

83

52
69

Appendix E: Finding Anomalies in Grayscale Infrared Video with ImageJ...................... 84
Appendix F: Creating an Overlay from ViewPoint Snapshots in Google Earth ............... 91
98
Appendix G: MATLAB Code for createMosaic Program .................................................
Appendix H: Creating a Google Earth Overlay for Any Image Using MATLAB.............. 100
Appendix I: Creating a Google Earth Image Overlay Using MATLAB.............................

102

1. Introduction
In the last several decades, Cyprus has struggled to meet the water demand for the country.
Nearly all of the island country's aquifers have a history of being over-pumped, often leading to
salt water intrusion and depletion. In the last decade the government has been forced to turn to
expensive desalination plants that have a substantial environmental impact to solve the water
deficit. While the current state of the nation's groundwater resources is relatively good compared
to past years thanks to higher than average rainfall and the desalination plants, investigation of
submarine groundwater discharge (SGD), an as of yet nearly untouched subject in Cyprus, would
help inform future coastal water management decisions and could even reveal untapped
freshwater resources.
SGD is the flow of water from a coastal aquifer into the ocean. It can be composed of either
fresh or salt water. This study focuses on freshwater SGD. While it usually occurs as slow,
diffuse flow across sandy sediments, in confined karstic or rocky aquifers discharge can emanate
from a single point source, creating submarine freshwater springs. These have been observed in
many countries surrounding Cyprus (Fleury 2007, Taniguchi 2002, Elhatip 2003, Gunay 1988,
Ghannam 1998). In some cases these springs have even been tapped and used as a supplemental
source of freshwater.
Prior to this study, the only information about SGD in Cyprus came from equations
describing groundwater flow and estimations of relevant parameters. The Cyprus Institute in
Nicosia has proposed a full scale experimental investigation of SGD to be carried out in the
spring, when precipitation and, consequently, SGD are highest. Before this investigation, an
experimental protocol specific to Cyprus needs to be developed and refined so that no time is
wasted in the spring, when time is a valuable commodity before summer hits, bringing with it
dry weather.
The purpose of this project is threefold: a) to develop an experimental procedure based on a
review of literature to locate SGD that can be carried out in Cyprus, b) to test the experimental
procedure, and c) to provide recommendations for the next investigation based on the experience
of testing the procedure.
Presented within this report is a summary of the information gathered from a review of
literature on SGD and an explanation of the procedure developed for Cyprus based on this
information. The results are provided from testing the procedure, both in Quonochontaug Pond,
Rhode Island, where prior studies showed evidence of SGD, and then in Chrysochou Bay,
Cyprus. Finally the experience of carrying out the procedure is described and recommendations
are made for a future iteration of this project.

2. Background

2.1 Submarine Groundwater Discharge
All aquifers that come in contact with the sea have a dynamic freshwater - salt water
interface; it can move either in towards land or out towards the sea when acted on by a number
of forces. The position of this interface can allow water to flow from the ocean into the aquifer
(salt water intrusion) or from the aquifer into the ocean (SGD).
Burnett defines submarine groundwater discharge as "any and all flow of water on
continental margins from the seabed to the coastal ocean, regardless of fluid composition or
driving force" (Burnett 2003). It can be caused by many factors and composed of freshwater
from the aquifer, recirculated sea water, or a combination of the two. In aquifers with a porous
top stratum (semiconfined aquifers) usually occurs as a slow, diffuse flow through the sediment.
In coastal aquifers with karstic or rocky outcroppings, a crack can cause SGD from a point
source that can create submarine springs.
Examples of driving factors of SGD include a hydraulic gradient, tidal pumping, wave setup, density gradients, thermal gradients, and topography (Bratton 2010, Burnett 2003). Because
the motivating forces behind groundwater discharge are many and often work together to
influence groundwater flow, SGD is temporally and spatially variable, which complicates efforts
to locate and understand it.
Bratton distinguishes three scales of SGD: the nearshore scale, which extends approximately
10 m out from the shoreline, the embayment scale, which covers the area from the first confining
unit to the 10 km from shore, and the shelf scale, which includes the entire continental shelf
(Bratton 2010). Fig. 1 shows each of these scales.

Figure 1: Bratton separates submarine groundwater discharge (SGD) into the nearshore
scale, embayment scale, and the shelf scale. Reproduced from Bratton (2010)
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Before understanding these scales, it is important to know what is meant by confined and
unconfined in the context of groundwater. A confined, or artesian, aquifer is enclosed by
impermeable surfaces on all sides, such as rock or karst. Confined aquifers often have high
internal pressure. Fissures or cracks in the boundaries of a confined aquifer can result in water
flowing out and above the water or ground level. The top of an unconfined, or phreatic, aquifer
consists of highly permeable soils. Often aquifers are layered such that the bottom stratum of an
unconfined aquifer is the top confining unit of a confined aquifer. An aquifer is semi-confined if
the top layer has a low permeability.
The nearshore scale includes the intertidal zone and is linked to shallow, unconfined
aquifers and topographically driven surface flow. It is the most studied and understood scale of
SGD. The embayment scale can feature diffuse seepage or point source discharge of freshwater,
potentially in substantial amounts. Because the groundwater at this depth will have had to travel
further, it is often relatively pure. Shelf scale SGD can include many confined aquifers and is
driven primarily by geothermal convection.
Understanding SGD is crucial in the study of coastal ecosystems, nutrient and contaminant
transport, groundwater management, and freshwater conservation. The primary factors
motivating this study are groundwater management and freshwater conservation.

2.2 SGD as an Exploitable Source of Freshwater
When groundwater discharges from a point source, it can create a submarine spring. Greek
and Roman folklore tell stories of sailors reaching over the side of a boat miles from shore and
pulling up a glass of water fresh enough to drink. Other accounts tell of collecting freshwater
from off shore to bring back for use on land. Pliny the Elder (ca. 1't century A.D.) is quoted by
Burnett as having written of "springs bubbling freshwater as if from pipes" in the Black Sea
(Burnett 2003). Modern technology has allowed these springs to be tapped and used to
supplement other sources of freshwater.

2.3 Methods of Identifyingand Measuring Freshwater SGD
Many different methods of measuring SGD both qualitatively and quantitatively have been
tested and proven capable. The spatial and temporal variability of SGD make it particularly
important to use a variety of these methods to fully characterize SGD in the area of interest. Each
of these methods has its own advantages and limitations which make them more or less
applicable for a given situation.

2.3.1 Hydrogeological Calculations
Hydrogeological calculations are often performed as a first step in estimating SGD
quantitatively. These calculations give no indication of location of SGD or of variations in

behavior of discharge with space or time, but do provide a quick means of estimating the amount
of water outflow to an ocean from a particular aquifer. Two equations can be used to
approximate SGD: Darcy's Law and water mass balance.
Groundwater flow rates are governed by Darcy's Law, which describes the rate at which
water flows through a porous medium. It states that

q = -K

dh

*

.-

(1)

where q is the Darcy flux, or flow rate per unit area, in [m/s], K is the saturated hydraulic
conductivity in [m/s], and dh/dL is the unitless hydraulic gradient, where h is the hydraulic head
and L is the distance.
The difficulty in using Darcy's Law to approximate SGD is finding appropriate values for
the saturated hydraulic conductivity and the hydraulic gradient. The saturated hydraulic
conductivity can be measured by performing a pump test through the sediment. The hydraulic
gradient must be measured with bore holes. If bore holes do not already exist in the aquifer of
interest, drilling them can be time intensive and costly. Both of these parameters also vary over
the aquifer; in order to get an estimation of flow with any credibility, they must be measured at
many locations for each aquifer. A review of several studies found that Darcy's Law calculations
often underestimate the actual amount of SGD measured directly (Burnett 2006).
The mass balance approach can be used to calculate SGD when all other inputs and outputs
are known. According to the conservation of mass,
Inflow = Outflow

(2)

which can be further broken down in the discussion of groundwater to the following:
Recharge + Sea Intrusion = Extraction + Groundwater Outflow + SGD

(3)

where recharge may include such factors as rainfall, river flows, return flow from irrigation,
return flow of domestic water supply, water losses from water supply networks, groundwater
inflow, and dam losses (Burnett 2006, Georgiou 2002). Groundwater outflow in this case
accounts for water that is eventually absorbed by trees or evaporated. Solving for SGD yields
SGD = Recharge + Sea Intrusion - Extraction - Groundwater Outflow

(4)

As with Darcy's Law, estimations of SGD using a water mass balance are only as good as
the data used to solve the equation; without a thorough database documenting groundwater
resources over an extended time period, it is difficult to obtain an accurate approximation.

2.3.2 Aerial Thermal Imaging
The temperature of groundwater tends to remain constant all year round. As a result, there is
often a temperature difference between SGD and the temperature of the ocean surface. When the
weather is warm, as in the summer in most places, groundwater is generally cooler than the
surface temperature, while when the weather is cold groundwater is usually warmer. This
temperature difference creates an SGD signature that can be spotted with thermal infrared
imaging (TIR).
Aerial TIR provides perhaps the most efficient means of locating areas with potential SGD
as temperature can be measured remotely and speed is generally limited only by how fast the
vehicle to which the camera is mounted can travel. As an efficient way to cover a large area, it is
often used as a first step of field work in an area where no prior information is known about
locations of SGD.
As with all of these methods, aerial imaging has its flaws. TIR has not yet been used to
estimate the amount of SGD. It also cannot differentiate between salt- and freshwater discharge.
Since TIR can only measure the temperature at the very surface, it may not show any evidence of
deep submarine springs or springs in areas where groundwater is very close to the ocean
temperature. The only way to reduce the chance of missing a submarine spring would be to use a
method of measuring temperature or other indicators of SGD would be with in situ
measurements that provide data over the depth of the ocean. These other methods are much
slower than using a remote sensor. Additionally if a submarine spring is large enough to affect
groundwater resources, it will likely be detectable through TIR.
In order to maximize the potential temperature difference, TIR should be performed several
hours after the sun has set, or as early in the morning as possible. The sun heats the surface of the
ocean to a uniform temperature, erasing any sign of SGD.
Thermal sensors on satellites, such as LANDSAT-7 or ASTER, are now capable of
detecting temperature differences for some large submarine springs and could supplement data
from TIR (Rokos 2009).

2.3.2.1 Infrared Thermography
Infrared cameras produce an image in which the color of each pixel is related to the amount
of infrared radiation is incident on the sensor in the corresponding location. All objects that are
warmer than absolute zero (0 K) emit blackbody radiation in the infrared spectrum. The rate of
energy emitted per unit area (or power per unit area) is given by the Stefan-Boltzmann Law as
follows:
j =

E

* a- * T4

(5)

wherej is the power emitted per unit area in [W/m 2 ], e is the unitless emissivity of the object, a is
the Stefan-Boltzmann constant, or 5.67 * 10-8 J/(s*m 2*K4), and T is the temperature of the object
in [K]. The fact that the amount of radiated energy is so strongly dependent on the temperature of
the object is what allows for infrared thermography. In general a higher temperature corresponds
to increased radiation incident on the camera's sensor. However, the relationship between the
temperature of an object and pixel color in an infrared image is complicated by the emissivity
and by other sources of radiation that can be incident on the camera as well.
The emissivity of an object is defined as the ratio of the amount of energy it radiates to
the amount radiated by an ideal blackbody. While emissivity is often considered a constant for a
given material, in reality it changes based on temperature, thickness of the material, and emission
angle. Various studies give the emissivity of the ocean surface as ranging from 0.984 (Konda
1994) to 0.992 (Masuda 1988).
In addition to the energy emitted by the object of the infrared image, there are also other
sources of radiation, such as energy that is transmitted through the object and energy that reflects
off the surface of the object. As a result, it is very difficult to calculate an absolute temperature
from infrared imaging. However, if it is assumed that these factors remain constant over the
period of obtaining infrared imaging, the images can be used to approximate temperature
differences. In locating temperature anomalies, the relative temperature difference is far more
important than the absolute temperature of the sea; thus infrared thermography is an appropriate
method for locating SGD.

2.3.3 Salinity
Measuring salinity is a sure-fire way to observe freshwater SGD as few other factors can
significantly alter the local salinity in an ocean. Because the concentration of salt is directly
related to the concentration of ions in water, in situ salinity is usually calculated from
measurements of conductivity, which is measured using an array of electrodes. These arrays are
sometimes contained within instruments which are lowered and raised in a single location to
measure salinity over the water column. Other resistivity arrays are designed to be towed behind
a boat. This is called continuous resistivity profiling, and may provide an alternative to aerial
TIR as an instrument for an efficient, large-scale investigation of SGD when no information is
known as to where it may be occurring. Because the resistivity arrays are towed, they are much
faster than measuring salinity by lowering and raising a handheld device. While they are slower
than aerial imaging, they provide the added benefits of giving information about temperature and
salinity over the depth of the sea. They can even be used to determine information about
groundwater under the sea bed (Day-Lewis 2006).
While salinity can be measured in situ much faster than most other chemical concentrations
can, it still takes much longer to measure values directly than it does with a remote sensor, such
as TIR. When possible, salinity should not be used as a first attempt to locate SGD; another
method, such as aerial imaging, should be employed first to narrow down the region of interest.
Unlike TIR, salinity measurements can often be made over the entire vertical water column,
giving an idea of what is happening under the surface. This makes salinity a more sensitive
indicator for detecting SGD, particularly in deep water. Additionally salinity measurements can

be used to get an approximation of SGD flux by comparing the concentration of salt in the
vicinity of the discharge source to that in the aquifer and in the surrounding ocean water and
accounting for the size of the area over which the low salinity values are observed.

2.3.4 Geochemical Tracers
Similar to using salinity to detect and quantify SGD, other geochemical tracers may be used
as well. Most groundwater naturally has enriched levels of nutrients or other contaminants
compared to the coastal ocean water. These can be used in the same way as salt to identify SGD
and approximate discharge rates. The type of sensor needed and the process of measuring the
tracer concentration depend on the type of tracer used, which depends on the composition of the
groundwater in the particular area under investigation. For this reason, a certain amount of
information needs to be known about the groundwater prior to selecting this method. The most
common tracers include radon-222, radium-226, methane, and boron, but many other isotopes
have been used as well (2H, 3H, 3He, 4He, 13C, 14C, 15N, 180, 87/88Sr). Even some
anthropogenic contaminants, such as chlorofluorocarbons (CFCs), have been used as a tracer
when present in groundwater (Burnett 2006).
Using this approach also requires knowledge of all the possible sources of the tracer that
could affect measurements. This can sometimes prove a difficult task. Another approach has
been to add a small amount of a tracer that is not naturally occurring into the water cycle. This is
not recommended due to the possible harmful effects of contaminating water supplies.
As with salinity, in situ measurements of geochemical tracers can be a tedious task; it is not
recommended as a method until some information is known as to the location of a potential
source of SGD.

2.3.5 Lee-Type Seepage Meters
A Lee-type seepage meter consists of the end of a 55 gallon drum with a plastic bag fixed to
it via a two-way valve, as shown in Fig. 2. The drum is planted in the sediment on the ocean
floor with a known amount of water in the plastic bag.

Water surface
Plastic
/

Bag

Seepage
Figure 2: A sketch of a Lee-type seepage meter that directly measures flow through the
sediment in either direction. Modified from Lee (1977).
At various time intervals, the volume of the plastic bag is measured. Originally, this was
done by removing and replacing the plastic bags. Now modem Lee-type meters have sensors that
can detect water flow through the valve. Starting with an initial volume of water in the bag
allows flow to be measured weather it flows through the sediment into the meter or from the
meter out through the sediment. Knowing the composition of the water that started in the bag
allows for calculation of composition of water that seeps into the bag through mass balance of
salt or other geochemical tracers.
Lee-type meters provide an accurate, direct measurement of SGD and can be left in place to
observe temporal discharge trends. They do, however, take a great deal of time and effort to
install, and provide extremely localized data. A large number of them would be required to
measure spatial variations. They also cannot be installed in karstic or rocky formations, where
point source discharge is expected.

2.3.6 Other Observable Signs of SGD
The first recorded instances of SGD were seen by sailors as early as the first century A.D.
(Burnett 2003). The signs included patches of differently colored water, bubbles at the surface,
and tasting freshwater in the ocean. Other signs include areas with abnormally dense fish
populations. Dr. Matthew Charette advised the author that, from his experience, the first step in

looking for SGD in a new area is asking the local fishermen if they knew of any of these
phenomena or other localized abnormalities.

2.4 Submarine Groundwater Discharge in Cyprus
A small, semi-arid island in the eastern Mediterranean, Cyprus has a history of water
shortages. The last several decades have been particularly dry, with the average rainfall dropping
from 515 mm/yr over the time period from 1961 - 2000, to 435 mm/yr from 1971 - 2000
(Georgiou 2002). For a long time, the majority of the country's aquifers were over-pumped
beyond sustainable rates (see Fig. 3). This has resulted in salt water intrusion in coastal aquifers
and depletion of inland aquifers.

Figure 3: Map of Cyprus showing aquifers and the ratio of over-pumping to
recommended extraction. The aquifers colored red are pumped at a rate more than twice
the recommended sustainable extraction. Reproduced from Georgiou (2002).
Because of the frequent water deficits, the Water Development Department (WDD) carried
out the Re-Assessment of the Water Resources and Demand of the Island of Cyprus project in
2002 with the help of the Food and Agriculture Organization of the United Nations (FAO). The
majority of the information about groundwater in Cyprus comes from this project. It should be
noted that almost all of the information is regarding the portion of the island under government
control; very little data is available about the part of Cyprus occupied by Turkey.

The total water demand' for Cyprus was estimated as 265.9 mcm/yr (ie million cubic meters
per year) in 2001 (Savvides 2001). This value has most likely increased since then due to
population growth. An assessment of groundwater resources approximated that the total
recommended sustainable extraction for all of the aquifers in government-controlled Cyprus is
on the order of 81 mcm/yr (Georgiou 2002). In the past decade the Cypriot government has been
forced to turn to desalination plants to make up the difference.
As of the end of 2010, desalination plants produced 65.7 mcm/yr (WDD 2010). Thanks to
these plants and higher than average rainfall in the past couple years, the water deficit has
shrunk. However desalination plants are not a perfect solution; they require 4.5 kWh of energy to
produce a cubic meter of potable water which costs approximately E 1.01 per cubic meter, which
is variable and highly dependent on oil prices (Manoli 2010). Additionally this water comes at
the price of greenhouse gas emissions and the as of yet unknown long-term consequences of
increased localized salinity due to brine rejection from these plants.
All studies of groundwater resources in Cyprus thus far have been based on mathematical
equations and models based on some measured data and a good deal of estimation and
experience on the part of the investigators. Approximations of SGD have been made using
Darcy's Law (1) and groundwater flow models applied to individual aquifers, and vary greatly.
The assessment of groundwater resources from 2002, which seems to be the most reliable and
transparent regarding methods, estimates that 24.6 mcm/yr is discharged into the sea (Georgiou
2002). A re-evaluation of groundwater resources performed in 2004 gives several different
approximations of sea losses, each obtained using slightly different models and input parameters.
The report first states that 72.7 mcm/yr is lost to the sea via both SGD and surface flow (i.e.
rivers and streams). Later in the report, the total value of sea losses is calculated as 217.2
mcm/yr, with no explanation as to the discrepancy. Estimates in different sections of the report
give the amount of water lost to the sea as surface flow as 18.8 mcm/yr and the amount lost as
groundwater discharge as 6 mcm/yr (Udluft 2004). Fig. 4 shows a map of Cyprus from this
report with arrows representing likely locations of SGD. It is clear from the range of these values
that further work is needed for more precise approximations of SGD.

Water demand is defined in this case as "the normal water requirement for any sector (Agriculture, Domestic,
Industry, etc.) expressed either as total amount or per unit area, per capita consumption etc. It is the necessary
water demand to cover the needs of a sector without shortage" (Savvides 2001). Water demand is usually greater
than water use, which varies year to year based on water availability.

Figure 4: Map showing localized estimations of SGD from the GRC report (Udluft
2004). These estimates come from Darcy's Law. Other estimates based on groundwater
flow models within the same report suggested that up to 217.2 mcm/yr (million cubic
meters per year) were discharged to the sea across the country. Reproduced from Udluft
(2004).
If a point source of SGD were found near Cyprus that was large enough to be tapped or
contained, it could potentially reduce the burden on the desalination plants, making the
investigation for SGD worthwhile. Even if this were not the case, however, any information that
could be used to produce a more accurate depiction of outflow to the sea in Cyprus would be
beneficial from a water policy and management perspective.

2.5 Proposed Procedure for Cyprus
Because no experimental work had been done in Cyprus to locate or quantify SGD prior to
this investigation, aerial TIR was selected as the first method to search for any indication of
groundwater discharge because it could quickly cover a large area. An infrared camera owned by
the Cyprus Institute was to be used for the study (further details can be found in Sections 4.1.2.1 4.1.2.2). A great deal of thought was put in to what type of vehicle to which to mount the
camera.

Vehicles considered included a manned, fixed winged aircraft, several models of fixedwinged UAVs (unmanned aerial vehicles) and RC (remote control) aircrafts, a small quadrotor
(UAV and/or RC), an RC blimp, and a weather balloon tethered to and towed by a boat. The
UAVs and RC aircrafts that were reasonable to make operational in the time frame of this project
did not have a long enough battery life for the planned mission and were too small to withstand
the wind speeds that they would face over the Mediterranean Sea. A tethered weather balloon
was a very tempting option, as it would allow the investigators to obtain data without the need
for a pilot and co-pilot. In the end, however, it was determined that the speed obtainable with a
manned aircraft made it a more cost-effective solution than renting a boat to which to tether the
balloon. More data could be obtained for a given price with the manned aircraft than with the
balloon towed by a boat.
After analyzing the data obtained from TIR, salinity would be tested in situ with a
Conductivity-Temperature-Depth (CTD) sensor in any areas that showed anomalous
temperatures. Using salinity as a tracer rather than any other chemical ensured that it would be
applicable across the entire island, whereas tracers naturally occurring in groundwater in one part
of the island may not necessarily be prevalent in another part.
For this first phase of the SGD project, the proposed procedure here described would be
carried out only over a small portion of the Cypriot coastline. Through this experience, it would
be improved upon. The revised procedure would then be tested and refined once more to make
final changes before a full-scale investigation of SGD in the coastal waters of the island was
launched in the spring, when rainfall, and thus SGD, is highest. With this end goal in mind, the
procedure was designed to be efficient and effective enough to eventually be carried out across
the whole coastline, over the range from 0-10 km from shore to cover nearshore and embayment
scales of SGD.
Prior to carrying out the procedure in Cyprus, a location was found in New England to test
certain aspects of the protocol and develop data processing methods.

3. Testing in Quonochontaug Pond, RI
Quonochontaug Pond is one of several salt water ponds along the coast of Rhode Island. It
covers an area of 3.02 km2 with an average depth of 1.8 m and average salinity of 29 ppt. It is
connected to the Atlantic Ocean via a large causeway and thus Prior work done in the area by Dr.
Charette, from Woods Hole Oceanographic Institute, provided the TIR shown in Fig. 5, which
shows areas of potential SGD.

Figure 5: Aerial thermal image of northeast coast of Quonochontaug Pond, RI showing
four locations with evidence of submarine groundwater discharge. Location 4 on the map
was selected to test the salinity profiling procedure. Infrared image provided courtesy of
Dr. Matthew Charette, through research made possible by the financial support of the
Woods Hole Oceanographic Institution's Coastal Ocean Institute and the Cove Point
Foundation. Google Earth screenshot: 0 2012 Google 0 2012 Europa Technologies C
2012 TerraMetrics.
Quonochontaug Pond (specifically location 4 shown in Fig. 5) was selected as a location to
perform a test run of the salinity profiling procedure prior to traveling to Cyprus.

3.1 Salinity Profiling

3.1.1 Conductivity, Temperature and Depth Sensor
The YSI CastAwayTM-CTD (S/N llB100023YSI Incorporated, Yellow Springs, OH) was
used to map the salinity in the northeast corner of the pond. The YSI CastAwayTM-CTD is
powered by two AA batteries, weighs approximately 1 lb., and records data at a sampling rate of
5 Hz. It is equipped with GPS which it uses to record the precise location and time at the start
and finish of each measurement. Every data point is linked to the corresponding locations and
times. The CTD comes pre-calibrated from the factory. The manufacturer recommends returning
the instrument to the factory yearly for re-calibration.

Three CTD-fixed sensors measure water conductivity, temperature, and pressure (Fig. 6).
Depth, salinity, specific conductance, and sound speed are derived from these properties. Only
salinity and depth are employed in the scope of this study
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Figure 6: YSI CastAwayTM - CTD showing sensor and electrode locations
Six electrodes within the CTD's flow-through channel are used to measure resistance; two
electrodes generate an electrical current while the other four electrodes measure resistivity. Only
two electrodes are necessary to measure resistance; the additional electrodes improve accuracy
and reduce the risk of calibration errors. From this measured resistivity, the conductivity of the
water in the cell is calculated with the equation:

C =

1

(6)

where C is the conductivity, I is the distance between the electrodes, R is the measured
resistivity, and A is the cross-sectional area of the flow-through channel. A thermistor, or a
material with a temperature-dependent resistance, provides the temperature data.

Conductivity of water is dependent on temperature, the concentration of ions present and
(to a lesser extent) pressure. The majority of ions in water come from salt. Thus salinity can be
derived from conductivity, temperature and pressure. This relationship is given by the Equation
of State of Seawater, or EOS-80. The EOS-80 conversion from conductivity to water is a
complicated series of four numerically developed (as opposed to analytically developed)
equations intended to be solved by a computer. Details of the computation, along with a
discussion of the practical salinity scale, can be found in the UNESCO technical paper,
"Algorithms for Computation of Fundamental Properties of Seawater" (Fofonoff 1983). This
computation is performed within the CTD.
Depth is not measured directly by the CTD, but rather a sensor measures the gauge
hydrostatic pressure, which is then used to calculate depth. The CTD uses the temperature and
salinity measurement to obtain water density and the latitude and altitude measured by the
internal GPS receiver to find the local acceleration due to gravity. Together these data allow for
the calculation of depth.
The CTD can take two types of measurements: casts and point measurements. In either case,
a rope is tied securely to a carabiner attached to one end of the instrument and to a fixed object
on the other end in case the rope were to slip. The rope can either be held in an investigator's
hands or lowered with a winch.
During a cast, the sensor is lowered to just below the surface of the water, where it is held
stationary for 5-10 seconds before it is allowed to free fall to the deepest point of measurement.
The instrument is then immediately raised at a recommended steady rate of approximately 1
meter per second. While moving through the water, the CTD takes a series of measurements at a
sample rate of 5 Hz. The result is a profile of the measured water properties with respect to
depth.
For a point measurement, the CTD is lowered to the desired position and moved either up
and down or back and forth to keep water flowing through the measurement cell for
approximately 5 seconds. All properties at that location are recorded as a single data point.
The CTD is capable of storing up to 15 MB of data, or approximately 750 typical casts. Data
collected can be reviewed on an LCD screen at any time. Bluetooth technology is used to
download data onto a Windows-compatible computer. Software accompanying the CTD allows
for easy viewing of locations of measurements and comparison of individual casts or point
measurement.

3.1.2 Determination of Measurement Locations
Before the field test date, Google Earth software was used to locate the area exhibiting signs
of SGD based on the aerial thermal images. In order to systematically determine measurement
locations, a grid was drawn over the area with intentionally smaller spatial resolution near the
shoreline where SGD was suspected, as shown in Fig. 7. The latitude and longitude at each of the
90 intersections of the grid was found using Google Earth; a list of each of these coordinates was
brought to Quonochontaug Pond on the day of testing.
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Figure 7: Grid was drawn over area of interest using Google Earth. Latitudinal and
longitudinal coordinates of each point of intersection on the grid were recorded and used
to determine measurement locations during field testing. Grid spacing was intentionally
smaller near northwest section of area where submarine groundwater discharge is
believed to occur based on aerial thermal image. Google Earth screenshot: C 2012
Google.
While the CTD tracks and records GPS locations for each measurement, it does not display
GPS coordinates between uses. Thus the investigator used a handheld Garmin GPSMAP 60CSx
Hiking GPS Receiver to find each of the pre-determined GPS coordinates for point
measurements.

3.1.3 Point Measurements of Salinity and Temperature
Field sampling was done on June 26, 2011 between 12:08pm and 4:30pm EST with a YSI
Castaway TM - CTD from onboard a kayak. Because water in the area of interest was very shallow
(ranging from approximately 0.2 m to 1.1 in), the CTD was used to obtain point measurements
rather than water column profiles. The CTD is designed to take measurements while water is
moving through the flow cell; thus in order to measure salinity and temperature, the CTD was
slowly moved for several seconds either back and forth or up and down through the water
depending on the depth of the water at that particular location.
Profiles were obtained by interpolating the measured properties between measurement
positions. The MATLAB scripts required to graph these profiles along with detailed instructions
of how these scripts are used are found in Appendices A-C.

3.2 Quonochontaug Pond Results and Discussion
Fig. 8 illustrates cast locations as recorded by GPS onboard the CTD and the resulting
salinity profile.
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Figure 8: Salinity profile as measured by CTD. The black diamonds denote locations of
point measurements given by GPS in CTD. Google Earth screenshot: C 2012 Google.
The majority of the measurements obtained gave salinities around 26 on the practical
salinity scale (orange in Fig. 8). Salinities near the northern coast drop down to approximately
20. This corresponds with the darkest area in Fig. 5, and is likely a result of freshwater discharge.
The dark blue patch on the western edge of the data collection region also corresponds to a
darker area on the infrared image in Fig. 5 that appears to originate from a stream. A list of the
salinity measurements are given in Appendix D.
The GPS coordinates of the intended measurement locations were brought onboard the
kayak during testing with the intent of measuring temperature and salinity at evenly distributed
points spanning the area of interest. It was difficult to specify a precise measurement location

due to wind moving the kayak and currents moving the CTD. Therefore, the intended locations
were used as guidelines. Although time consuming to find in the kayak, the printed GPS
coordinates were helpful in open water to ensure that the entire area was covered. However, near
the coastline or around anchored boats it was easy to navigate the kayak in a straight line using
these as reference points, so measurements were taken at locations determined by the
investigator on site rather than finding the GPS coordinates.
Some points at which measurements were desired were left off due to obstructions in the
pond. Nests and wildlife along the shoreline prevented measurements from being taken too close
to the coast. Other points were unreachable due to thick plants that had grown in since the
satellite image, which was used to grid the area, was taken.
Because Quonochontaug Pond has a large breach-way directly connected to the Atlantic
Ocean, it experiences high and low tides. Testing occurred between low tide, which occurred at
11:00am, and high tide, which occurred at 5:33pm. Because SGD is driven by the hydraulic
gradient between groundwater and sea level, SGD rates are highest, and thus most observable,
during low tide. Testing could not occur entirely at low tide due to the time-intensive process.
After the entire area was measured, the north shore, where measurements were taken first, was
revisited. The results did not differ significantly from the initial measurements.

4. Testing in Cyprus
Before the procedure could be tested, a location was selected based on the likelihood that
SGD would be observed and how easily the procedure could be implemented. The investigation
was limited to the southern, Greek-Cypriot side of the island due to political reasons. Based
estimations of SGD in the GRC report (shown in Fig. 4), the focus was narrowed to Episkopi
Bay along the southern coast and Chrysochou Bay on the northwest coast. Several local
fishermen and residents of Polis and surrounding cities claimed to have seen signs of water
discharge in Chrysochou Bay, including areas of unexpectedly high fish populations, water
appearing to be drunk by animals at certain spots along the coast, and bubbles at the surface at
low tide on calm days. Based on this combination of information, Chrysochou Bay was selected
as the ideal location for testing the procedure.
By design, TIR was intended to be performed prior to salinity measurements. The results of
the aerial imaging data would determine locations of salinity testing. However, permission to fly
data acquisition missions was not granted by the Cyprus Department of Civil Aviation in time to
allow this. As a result, the procedure was altered to accommodate taking salinity measurements
prior to aerial imaging.

4.1 Procedure
3.1.1 Salinity Measurements
The same YSI CastawayTM - CTD used in Quonochontaug Pond as discussed previously
was used in Cyprus. The primary differences were the depth of the water and the vehicle from
which the CTD was used. While in Rhode Island the shallow water necessitated point
measurements, in Cyprus the cast feature of the CTD was used to measure salinity over the full
water column. In order to perform these casts, the CTD was attached to a motorized fishing rod
via a fishing line rated for 200 lbs of force. The rod was set to lower and raise the instrument at a
fixed speed of 1 m/s, as recommended by YSI. Measurements were taken from onboard an
inflatable commercial fishing boat.
The boat was rented for the day along with its captain. The captain was told of the purpose
of the investigation prior to being hired. He was familiar with the phenomenon of SGD and had
heard of and witnessed signs of SGD in Chrysochou Bay. Three locations were visited based on
his recommendation, as shown in Fig. 9.

Figure 9: Locations in Chrysochou Bay singled out by fishermen and locals as showing
signs of freshwater SGD. Signs included: goats appearing to drink water from the ocean,
higher localized fish populations, and bubbles at the ocean surface on calm days. Salinity
was measured at each of these locations. Google Earth screenshots: Left: C 2012 Europa
Technologies, Image C 2012 DigitalGlobe, © 2012 Google, Data SIO, NOAA, US Navy,
NGA, GEBCO. Right: Image © 2012 DigitalGlobe, Data SIO, NOAA, US Navy, NGA,
GEBCO.

At each spot sample casts were performed to determine whether salinity measurements were
anomalous in that area, using the LCD screen on the CTD to check the data on site. The number
of sample casts ranged from two to fifteen depending on the size of the area. If low salinities
were observed, salinity measurements were repeated throughout the entire area to obtain
adequate data to produce a salinity profile. The data recorded during each cast was used to
inform the spacing between subsequent measurements; if a low salinity was measured, the
distribution of cast locations in the immediate vicinity of that cast was denser than if the
measured salinity was high.

4.1.2 Aerial Imaging
4.1.2.1 Infrared Video Camera
The infrared camera used to obtain the TIR video in Cyprus was the FUR Photon 640,
equipped with a 60mm lens. The Photon 640 is designed for minimal payload for aerial
applications. The sensor is a 640 x 512 uncooled vanadium oxide microbolometer array. It has a
spectral band of 7.5 to 13.5 pim and a noise equivalent differential temperature - which is
representative of the minimum detectable temperature difference - of 50 mK. This is more
sensitive than most cameras used for aerial TIR studies of SGD, which are commonly 100 mK
(Mulligan 2005, Duarte 2006, Johnson 2008). It should be noted however that while the sensor is
capable of detecting these temperatures, the 8-bit analog video output significantly limits the
temperature differences shown by the final data. The video produced is National Television
System Committee (NTSC) analog video, which has a frame rate of 30 Hz. The lens used with
the camera has a focal length of 60 mm and a field of view of 150 by 110. The instantaneous field
of view is 0.416 milliradians. Together, these specifications can be used to calculate the
dimensions of the area captured by the camera in a single frame and in a single pixel within that
frame as shown in Fig. 10.

VFOV

Figure 10: The horizontal and vertical length (H and V respectively) of the area captured
by the camera within a single frame and within a single pixel can be calculated using the
horizontal and vertical, and instantaneous fields of view (HFOV, VFOV and IFOV) of the
lens as well as the distance of the lens from the image plane (a).
From this image, it is clear that the horizontal length, H, and the vertical length, V, of the
area captured in a frame are given by

2a * tan (HFOV)

(7)

V = 2a * tan (VFOV)

(8)

H

and

=

where a is the distance between the camera and the target (in this case the altitude of the plane
and HFOV and VFOV are the angular horizontal and vertical (respectively) fields of view of the
lens. The small angle approximation gives that the length of either side of the area depicted by
any individual pixel, p, is

p = a*

IFOV

(9)

where IFOV is the angular instantaneous field of view of the lens. Given a desired spatial
resolution, Eqn. (9) can be used to calculate the necessary altitude. For example, if a resolution

of 0.5 m per pixel is desired, Eqn. (9) is solved for a using the camera's IFOV of 0.416
milliradians, giving

a-=

0.5 m

0.416 * 10-3

= 1202 m

Thus if the camera is 1202 m away from the subject being recorded (i.e. the plane is flown at
an altitude of 1202 m in the case of aerial imaging of the ocean surface), each pixel will
represent a square with sides of length 0.5 m. The entire area shown in a frame can be found by
applying Eqn. (7) and (8), which give

H

and

2 * 1202 m * tan (

V= 2 * 1202 m * tan

)

= 316.5 m

) = 231.5 m

In the case of surveying a large area using the infrared camera such as was done within this
study, Eqn. (7) can be used to calculate the width covered in a single pass, and therefore the
allowable distance between consecutive parallel passes to achieve desired overlap of images,
ensuring full coverage of the area under investigation.

4.1.2.2 Cloud Cap Technology Gimbal
The FLIR Photon 640 infrared camera was used as an integrated component along with a
visual camera in a Cloud Cap Technology Tase200 Gimbal, shown in Fig. 11. For the purposes
of this investigation, only the infrared camera was used to collect data. All user interfacing was
done with the Cloud Cap gimbal and associated software rather than directly with the FLIR
camera. The visual camera was occasionally used to assess camera mount vibration or to orient
the gimbal in situations where infrared video was inadequate.

Figure 11: A Cloud Cap Technology TASE200 Gimbal, shown here, was used to obtain
thermal images. Image reproduced from CloudCapTech.com
When in use, the camera is connected to a laptop on which ViewPoint, the Cloud Cap
software, is running (see Fig. 12). Through ViewPoint, the investigator is able to watch the video
feed in real time, adjust camera orientation, monitor GPS and other data, and change certain
settings on the camera. After recording the data, ViewPoint can also be used to export the video
recorded and the GPS data associated with specified frames to a form usable by other programs.
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Figure 12: Screen shot of ViewPoint software during camera operations. Displays, from
top left, status lights, playback controls, streaming video, gimbal telemetry data, and
image footprint on map.

The output from the IR camera is video made from a series of 640x480 8-bit grayscale
images. This means that based on the amount of incident energy on the camera's sensor, every
pixel within a frame is assigned a value from 0 to 255. This value is called the pixel intensity. A
pixel with an intensity of 0 is shown as black, 255 is shown as white, and all others fall on the
spectrum from black to white.

4.1.2.3 Relating Infrared Images to Temperature Differences
As discussed in Section 2.3.2.1, the absolute temperature is difficult to calculate from TIR
and is not necessary in finding anomalous areas indicative of SGD; however, if a relationship
were known between the image output from the IR camera and the temperature of the subject of
the image, it would be possible to determine a difference in temperature between two areas in a
frame by measuring the difference in pixel intensities.
In order to quantify the relative difference in temperature between different pixel intensities
in the resulting image, a glass of ice water was recorded using the gimbal in the lab as it warmed
to room temperature (see Fig. 13).
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Figure 13: Camera Calibration Set Up

The temperature of the water was measured using a Fluke temperature integrated digital
multimeter probe at time intervals determined by the rate of change of the temperature of the
water. The time of measurement was also recorded and used to correlate the temperature
measurement to a given frame. The frame was then exported as a snapshot from the ViewPoint
software and ImageJ was used to measure the mode pixel intensity within the cup. The mode was
used rather than the mean because there was a clear radial gradient in pixel intensity, which
caused a large variation in mean based on the selection area. Because the camera adjusted
brightness to keep the average temperature in a given frame at the middle of the grayscale
spectrum, at a pixel intensity of approximately 127, the background color changed throughout
the recording. To compensate for this, the average background pixel intensity was subtracted
from the water pixel intensity.
Once the cup of cold water had warmed sufficiently close to room temperature, the
procedure was repeated with a cup of warm water. The measured relationship between
temperature and pixel intensity is shown in Fig. 14.
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Figure 14: The relationship between temperature and pixel intensity was measured in a
lab setting. A cup of first cold water and then of hot water were recorded as they
approached room temperature. The differences between the mode pixel intensities within
the cup and the mean pixel intensities of the background and the temperatures of the
water in the corresponding frames were measured and are shown here.

A curve fit to the data had the equation

p = -0.007T

3

+ 0.5607T 2 - 5.0058T - 124.01

(10)

where p is the difference between mode water pixel intensity and the mean background pixel
intensity and T is the temperature of the water. The R2 value for the fit curve was 0.9982,
indicating a good fit.
The original intent of this was to determine the difference in pixel intensities that
constituted a significant variation. However, time did not allow these results to be verified. For
this investigation, any areas that could be identified as anomalous were considered significant.
Further work should be done in the future to better understand the relationship between pixel
intensity and temperature using this gimbal.
4.1.2.4 Flight Vehicle
A Cessna 172 Skyhawk was chosen as the appropriate vehicle for acquiring TIR due to its
accessibility in Cyprus and flexibility in flight mission capabilities. The aircraft was hired along
with a pilot and co-pilot by the hour. The gimbal was mounted on a support beam as shown in
Fig. 15.

Figure 15: The gimbal was mounted to a support beam on a Cessna 172 Skyhawk. The
mount was built by one of the pilots hired to fly the plane. Vibration-dampening mounts
supplied by Cloud Cap were used between the camera and the mount structure.
The gimbal mount was built by the hired pilot and consisted of a structure made of wood
reinforced with woven fiberglass fabric. The structure was affixed to the beam via several cable
ties. Efforts to minimize vibration included vibration-dampening compression mounts, which
were supplied by Cloud Cap, between the gimbal and the mounting structure, and a layer of foam
between the mount structure and the beam. The gimbal's GPS unit was cable-tied to a protruding
rail on the nose of the aircraft. Any lengths of wires on the outside of the plane were taped to the
side of the plane to keep them from moving during flight.
Wires from the gimbal system were run through the window to the back seat, where two
investigators had a laptop computer running the ViewPoint software. A lithium ion battery
onboard the aircraft supplied power to the camera. The voltage of this battery was checked often;
if it were to run low, it would be substituted by a spare battery that was also onboard. An inverter

and a 12 V lead acid battery were used to power the laptop. Both of these were fixed to a wooden
board which was then secured to the floor in the rear of the plane to eliminate the risk of these
heavy objects causing injury should the aircraft experience turbulence or other problems.
A test flight was used prior to the data acquisition flights to ensure that all equipment
functioned properly and that the vibration of the gimbal would not impede the video feed.

4.1.2.5 Aerial Imaging Procedure
Data acquisition missions were flown on August 4th and August 5th, 2011. Because the sun
tends to heat the sea surface to a uniform temperature after it has been up for more than a couple
hours, both flights were scheduled to take off as early as possible from the Larnaca airport.
Typically Larnaca is foggy around sunrise, so the plane took off as soon as the fog had cleared to
a safe level. All data was obtained between the hours of 8:30 am and 9:15 am local time.
A flight plan that included waypoint GPS coordinates and headings was made and discussed
with the pilots prior to take off (see Fig. 16).

Figure 16: Flight path created in Google Earth. A copy of the above image and a list of
waypoint GPS coordinates were given to the pilots prior to takeoff. C 2011 Europa
Technologies, Data SIO, NOAA, US Navy, NGA, GEBCO, C 2011 Google, Image
C 2011 DigitalGlobe.
The studies used to inform the design of the experimental protocol used a spatial resolution
ranging from 0.2 m per pixel (Torgersen 2000) to 3 m per pixel (Duarte 2006) in aerial thermal
images, with the majority of the studies falling within the 0.5 m to 1.0 m per pixel range. It was

determined that a flight altitude between 1200 m and 2400 m would give appropriate spatial
resolutions using Eqn. (9) was used with the lens' IFOV of 0.416 milliradians. Given this range
of acceptable altitudes, the pilots chose to fly at 1200 m, resulting in a spatial resolution of
approximately 0.5 m per pixel. The horizontal field of view was calculated using eqn. (7) to be
316 m. Using a 10% overlap between consecutive passes to minimize the risks of gaps in the
data, it was found that each parallel pass across the area should be approximately 284 m away
from the previous pass. These dimensions were used in creating the flight path shown in Fig. 16.
Two investigators sitting in the back of the plane watched and recorded the video feed from
the gimbal using ViewPoint. The gimbal was set to automatically adjust to maintain a position
directed normal to the ocean surface regardless of the orientation of the plane.

4.1.2.6 Video Post-Processing Procedure
After the data was obtained, the video was exported to an .avi file using ViewPoint software.
ImageJ was then used to compress the video and then identify temperature anomalies through
watching the video. The frames containing the anomalies were then exported as .jpg images from
ViewPoint along with .kml files containing the GPS coordinates of the four corners of that frame
as obtained from the Cloud Cap GPS receiver and information regarding the orientation of the
camera, gimbal, and plane. A MATLAB program was used to add color to the frames, remove
the border that appears on the frames exported from ViewPoint, and open the images in Google
Earth in the correct location. Appendices E - H describe the post-processing procedure in more
detail and provide the MATLAB code.

4.2 Results and Discussion
The procedures for aerial thermal imaging and salinity profiling were carried out as
described above in Chrysochou Bay, Cyprus. Anomalies were found both in salinity and
temperature, proving that these procedures are capable of producing the expected results. While
the delay in obtaining permission to perform data acquisition flights was not ideal, it did not
prevent the TIR procedure and the salinity profiling procedure from being tested independently.
Further work must be done to elaborate on the integration of the two techniques.

4.2.1 Salinity
Of the 72 salinity measurements taken, almost all were within the range from 30 to 60 on the
practical salinity scale. In one of the locations selected for salinity measurements, low salinities
were measured in the vicinity of 350 04' 34.54" N, 320 18' 59.09" N. This particular cove was

selected because fishermen claimed to see goats drinking water from the area. While goats were
present on the day of investigation, they were not witnessed drinking water.
Salinity profiles of the cove, shown in Fig. 17, were produced at 0.5 m depth intervals as
described in Appendix B. To put these profiles in geographical context, Fig. 18 shows the
salinity profile at the ocean surface superimposed on an image from Google Earth.
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Figure 17: Salinity profiles at depths intervals of 0.5 m of the cove shown in Fig. 18.
Values measured dropped as low as 0 in some locations, indicating freshwater. Axes are
labeled with GPS coordinates. The black diamonds show the location of casts. The blue
areas were shown in the profiles represent abnormally low salinity measurements. The
points beginning at a depth of 3 m that lie outside the colored area on the graph indicate
that at that location the cove was shallower than the depth of the profile.

I
Figure 18: The salinity profile from Fig. 17, shown here at a depth of 0.25 m, depicts
anomalous measurements in context on an image from Google Earth. The cove is
centered at 35004'40.32' N, 320 18'54.35" E. Google Earth Screenshot: C 2012 Basarsoft,
C 2012 Google, Image C 2012 DigitalGlobe, © 2012 Europa Technologies.
A compilation of the salinity profiled over depth for all of the casts on the same axes in Fig.
19 provides insight into the horizontal salinity profiles. Only three casts measured low salinities.
Each of these casts showed a salinity of zero at the surface and a steep rise in salinity between 2
m and 3 m deep. Two of the casts increased to match the average salinity measured across the
rest of the cove while the third cast plateaued at a salinity of approximately 17 until a depth of 5
m, at which point salinity increased to approximately 37. In the bottom half of a meter at this
location, salinity decreased again to 27.
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Figure 19: Salinity measured over depth for the cove shown in Fig. 17-18. Each line
represents a single cast. The blue patches showing low salinities in Fig. 17 are due to the
three casts shown here in orange, green and black that extend much lower on the practical
salinity scale than the rest of the measurements.

The shapes of the three anomalous casts are as would be expected in the vicinity of freshwater SGD,
as freshwater is less dense than salt water. This could create a freshwater layer on top of the salt water,
which would explain how goats could drink from the ocean in the area. The drop in salinity again for the
cast shown in green in Fig. 19 could suggest that it was near an input point of freshwater. Further
investigation of this area would help to clarify these results.

4.2.2 Thermal Imaging
While many areas in the aerial imaging data showed localized cold zones on the order of
a few meters, three locations, shown in Fig. 20, stood out as particularly large areas of

anomalous temperatures. The cove in which abnormally low salinities were measured is included
as a fourth area of interest.

Figure 20: The three large anomalous areas identified by the aerial TIR are shown above
(locations 1, 2 and 4). TIR is also provided for the cove in which low salinities were
measured (location 3). Google Earth screenshot: Image C 2012 DigitalGlobe, Data SIO,
NOAA, US Navy, NGA, GEBCO.
The resulting images from the aerial TIR are shown in Fig. 21-24. The contrast in the image
has been spread to make subtle differences easier to see. Areas in these images that are green are
land, and blue of all shades is water. The areas indicative of discharge are distinctive in that there
is an abrupt, well-defined change in the shade of blue; areas that appear pixelated, gradients in a
given frame, or changes in background color from frame to the next are due to inherent
variations in incident energy due to the orientation of the camera or the camera adjusting
brightness to best fit the range of temperatures in the frame. These should not be mistaken for
indications of SGD. The abnormalities that could be indicative of SGD are outlined in white.
The largest of the areas of interest was at the mouth of the Chrysochou River, at location 4
in Fig. 20. The aerial images of this area are shown in Fig. 21. Surprisingly, even though the
riverbed was dry in early August when the TIR data was obtained, the images indicate that there
may still have been discharge at the mouth of the river. Note that the background changing color
between frames is due to the camera adjusting brightness and is not indicative of a temperature

change; the abrupt change within a particular frame that then continues into other frames,
however, could be.

Figure 21: Cold temperature pattern at the mouth of the Chrysochou River (location 4 in
Fig. 20) as recorded in aerial thermal imaging. Even though the river was dry when these
images were taken, the TIR are indicative of some discharge into the sea. Google Earth
screenshot: C 2012 Europa Technologies, C 2012 Basarsoft, © 2012 Google, Image C
2012 DigitalGlobe.
A similar but smaller pattern was observed just north of Blue Lagoon, location 2 in Fig. 20,
centered at 350 05' 17.28" N 320 18' 03.66" E, as shown in Fig. 22.

Figure 22: Images indicating a potential area of cold water following the shape of the
shoreline just north of Blue Lagoon, location 2 in Fig. 20. Google Earth screenshot:
Image C 2012 DigitalGlobe.
A small cove towards the northern tip of the Akamas Peninsula (location 1 in Fig. 20)
showed a distinct temperature difference from surrounding area. The cove, which is centered at
3506'02.44" N 32 17'35.34" E is depicted in Fig. 23.

Figure 23: A small cove at location 1 in Fig.20 exhibited a very clear temperature
difference from the surrounding water. Google Earth screenshot: Image © 2012
DigitalGlobe.
While the bay in which abnormally low salinities were measured (see Fig. 17-18) did not
stand out on its own in the aerial thermal images, it is shown here in Fig. 24 to supplement the
salinity data.

Figure 24: Aerial thermal images of the cove in which atypically low salinity
measurements were made (location 3 in Fig. 20). The area indicated by the arrow is
suggestive of colder water and may be related to the anomalous salinities measured.
Further investigation is required to determine whether this is the case. Google Earth
screenshot: Image C DigitalGlobe.
As discussed in Section 2.3.2, submarine springs could exist that did not show up in the
TIR imaging. Unfortunately the only way of knowing would be to use in situ measurements that
can provide information over the depth of the sea rather than a remote sensor. This would be
significantly slower and should only be used after TIR has been performed and all anomalous
areas that were found have been investigated. Any amount of SGD that is large enough to affect
groundwater resources or to consider an exploitable resource will likely be visible using TIR.
Alternatively, TIR may provide false evidence of SGD. Anomalous areas in an image could
be due to an anomalous temperature of the water, but could also be attributed to a differing angle
of incidence of the camera affecting the amount of energy measured by the sensor or vegetation
transmitting infrared radiation through the water in shallow areas. Even if a particular location
does have an abnormal temperature, it could be caused by a number of potential factors, of which
a source of SGD is only one. Aerial TIR needs to be supplemented by other methods of detection
of SGD to fully understand its characteristics. The aforementioned areas should be used as
testing grounds for other methods until SGD is either ruled out or verified.

4.2.3 Discussion and Recommendations
The intent of this project was to develop the first iteration of a procedure to locate SGD in
Cyprus. The procedure was tested as described above. Based on the experience of carrying out
the procedure, recommendations for the next iteration are as follows.
While an area exemplifying anomalous salinities was found, demonstrating the capability of
salinity profiling with a CTD, carrying out the procedure proved a tedious and inefficient task.
Without having thermal images to inform measurement locations, the investigators were
restricted to a somewhat arbitrary guess and check method. While the areas of interest were
selected based on recommendations from fishermen and local citizens, these areas were likely
much larger than the observable footprint of potential SGD. Using the CTD, which can only
measure a single water column at a time, is not an appropriate method for the initial attempt at
locating SGD. The fact that an anomalous area was found, however, is an encouraging outcome
for performing salinity measurements in this manner as a follow-up to TIR in future studies.
Several issues arose from aerial thermography through a Cloud Cap gimbal mounted on a
manned aircraft. As mentioned previously, it is imperative that the TIR be obtained as early as
possible to record the biggest temperature differences. Before takeoff, the sun had to have risen,
the passengers had to pick up passes from civil aviation, the gimbal had to be mounted to the
plane, the plane had to be fueled, and permission for takeoff had to be granted from the control
tower. Additionally, the flight had to take off from the airport in Larnaca, which was just over
100 km from Chrysochou Bay; a detour around the Troodos Mountains that stand in the way
must be added to that distance as well. After all of this, aerial imaging of Chrysochou Bay did
not begin until 8:30 am, an hour and a half after sunrise.
Another issue was that the planes available were not fumished with adequate navigation
equipment for the type of precision flying required for a scientific mission. Fig. 25 shows the
intended flight plan given to the pilots prior to the flight and the actual area covered over the two
flights.

a) Intended flight plan to obtain complete coverage

b) Actual aerial imaging coverage over the two flights
Figure 25: Due to a lack of navigation equipment, the intended flight plan could not be
followed as closely as desired. The actual path left gaps in data. Certain areas were
passed over many times while others were missed entirely. Google Earth screenshot: 0
2011 Europa Technologies, © 2011 Google, Data SIO, NOAA, US Navy, NGA,
GEBCO, Image © 2012 DigitalGlobe.
Most, if not all of these problems could be solved by using a UAV to carry the gimbal rather
than a manned aircraft. There are far fewer restrictions placed on UAV flights than on manned
flights. This means the vehicle could take off from nearby the area of interest and at any time,
regardless of sunrise or fog, allowing aerial thermography to begin earlier, capturing the

maximum temperature differences. The autopilot software and sensors on a UAV are designed to
fly missions of this nature and hit waypoints with more precision and accuracy than a human
pilot could. As an added benefit, UAVs are significantly cheaper to operate than renting a
manned aircraft. Because of the lost time in the early morning, the inability to efficiently and
effectively cover a full area thoroughly, and the expensive nature of manned aircrafts, a full-scale
investigation of SGD near Cyprus should not be attempted until a UAV is available for use.
Unfortunately, no comment can be made on the integration of the aerial imaging and the
salinity testing as circumstances beyond the control of the investigator did not allow for TIR to
be performed before salinity testing as intended. However, with the use of a UAV rather than a
manned aircraft, the results of this study suggest that the procedure is capable of detecting
anomalous temperatures and salinities, both of which are indications of SGD.
A future iteration of this procedure may find it useful to use towed resistivity arrays. These
are capable of measuring both temperature and salinity at the same time while being towed
behind a boat. This would be a valid alternative if a UAV were not available to perform the
aerial thermal imaging. It would also provide the added benefit that the towed arrays can
measure temperature not only at the surface, but also over depth.
After locating areas that show signs of SGD, the next step would be to develop a procedure
to detect and quantify it using the other methods discussed in Section 2.3 that were not
implemented here. Additionally efforts should be made to monitor the site over time to fully
understand the temporal characteristics of the discharge. Together these methods will provide a
comprehensive understanding of SGD in Cyprus which can be used to inform groundwater
management.

5. Conclusions
The purpose of this collaborative project between MIT and the Cyprus Institute was to a)
develop an experimental procedure based on a review of literature to locate freshwater SGD in
Cyprus, b) to test the developed procedure in Cyprus over a sample area, and c) make
recommendations for a future investigations based on the outcome of the test. Each of these tasks
has been accomplished. The developed protocol consisted of aerial TIR to efficiently cover a
broad area searching for temperature anomalies indicative of SGD, then to return to those areas
to measure salinity in situ using a CTD. Before traveling to Cyprus, the salinity measurement
procedure was tested in Quonochontaug Pond, RI, at a location that prior TIR showed as a likely
spot for SGD.
When in Cyprus, Chrysochou Bay was selected as a testing location based on relatively high
estimates of SGD from Darcy's Law applied to aquifers in the area and indications of SGD
witnessed by local fishermen. Unfortunately, permission to perform the TIR flight was not
granted in time to allow aerial imaging to be done prior to salinity testing as intended; as a result
salinity testing was performed first, using the experience of local fishermen to determine areas
that showed potential signs of SGD. One of the locations tested did indeed show salinity
measurements that dropped as low as 0 on the practical salinity scale, indicating freshwater. TIR
was performed after the salinity measurements. Several spots along the coastline were found that

exhibited abnormally low temperatures, as would be expected in the vicinity of groundwater
discharge. The fact that anomalous areas were found when measuring both salinity and
temperature through the procedure herein developed suggests the equipment and methods used
are independently capable of achieving their desired results. Testing the integration of the two
methods is regrettably left to future studies.
While the procedures did accomplish what they were intended to do, recommendations can
be made to make future iterations of the procedures smoother. Firstly and most importantly, the
manned aircraft was ill-equipped to perform precision flights of the nature needed to obtain TIR
over an entire area. The navigation equipment on board did not allow the plane to hit the
waypoints with the accuracy desired, resulting in gaps in some areas of the imaging and other
areas that were flown over several times in a row. Also delays related to preparing for flight in a
manned aircraft made it impossible to take off early enough to record sufficient images before
the sun had been up for a couple hours, warming the surface of the sea to a uniform temperature
and minimizing, if not eliminating completely, any temperature differences caused by SGD.
Renting a manned aircraft along with a pilot and co-pilot is too costly to continue given these
issues. Future iterations of the TIR procedure should not begin until a UAV is available that is
designed precisely for flights of this nature.
The salinity procedure itself went very well; the only issue was that it is time-consuming.
Without having TIR images to show potential locations of SGD and inform the salinity
measurement locations, it is an inefficient process.
A future iteration of the procedure may want to consider trying towed resistivity arrays,
particularly in the absence of a functional UAV. The towed resistivity arrays combine the
measurement of salinity and temperature into a single instrument, as does the CTD. Because it is
towed, however, it will be significantly faster than covering the same amount of ground with the
CTD, albeit slower than aerial TIR. Additionally some thought should be given to methods to
quantify SGD and determine temporal variations once a location is identified. This could be done
using salinity measurements, but the addition of other methods of measuring SGD will allow for
more accurate results.
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Appendix A. Using Google Earth to Find Waypoints
In the scope of this study, Google Earth was used to find waypoints in salinity testing in
Quonochontaug Pond and in planning the flight route for obtaining aerial thermal images (Fig.
26).

Figure 26: Grids made in Google Earth to find GPS coordinates used for salinity testing
in Quonochontaug Pond (left) and for flight path in Chrysochou Bay, Cyprus (right).
Google Earth screenshots: Quonochontaug Pond: C 2012 Google. Chrysochou Bay: ©
2011 Europa Technologies, Data SIO, NOAA, US Navy, NGA, GEBCO, C 2011
Google, Image © 2011 DigitalGlobe.
Google Earth allows the user to create lines such as those shown in Fig. 26 one at a time.
Some thought needs to be done by the user in determining what the important aspects of the grid
are. For instance, the grid made for Quonochontaug Pond was used as rough coordinates for the
investigator to find via kayak; because it was very hard to find exact GPS coordinates and remain
stationary there for the measurement, a very precise grid was not necessary. However, the flight
path in Cyprus needed to have precisely spaced lines to ensure the images recorded over
consecutive passes overlapped appropriately to avoid gaps in the data. Depending on the mission
at hand, the user can choose to have evenly spaced, parallel lines that are time-intensive to
create, or quickly made but imprecise grids.
Google Earth can be downloaded from http://www.google.com/earth/index.html. To
create grids:
1. Find the geographic area of interest by typing in GPS coordinates or a location name,
dragging the map to the appropriate location, or using the navigational tools in the
upper left corner of the map.
2. Once the geographical location is found, open the Ruler window (Tools > Ruler; or

the ruler icon I 11).
3. Make sure the Line tab is open. Select the applicable units from the drop down menu.
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Figure 27: Google Earth Ruler menu
4. Click on the point where the first line is to begin. As the cursor is moved, the length
and heading of the line shown in the ruler menu update to reflect the current
measurements of the line. If the box next to "Mouse Navigation" is checked, the user
can click and hold to drag the map to a new location without locking down the
endpoint of the line.
5. When the length, heading, and/or appearance of the line is satisfactory, click the left
mouse button to select the endpoint of the line.
6. Click the Save button before clicking anywhere else on the map. Clicking elsewhere
will begin a new line, deleting the previous line.
7. The New Path window will open. From this window, the color, width and opacity of
the line can be changed, the length can be viewed, and a description can be added.
Generally the default options will suffice.
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Figure 28: Google Earth New Path menu

8. In some cases, it may be appropriate to change the name of the line to facilitate
working with the grid once it is created. This should be done now.
9. Click Ok. The name of the line will appear in the sidebar at the left hand side of the
screen under "My Places".

Figure 29: Google Earth screen shot. The names of the lines being drawn on the map can
be seen on the left-hand side of the screen, under "Places". Google Earth screenshot: C
2011 Google, © 2011 Europa Technologies, Image © 2011 DigitalGlobe, Data SIO,
NOAA, US Navy, NGA, GEBCO.
10. Repeat steps 2 through 9 until the grid is complete.
11. If at any point the properties of a line need to be changed or a line needs to be deleted,
this can be done by right-clicking on the name of the line in the sidebar.
12. To obtain the GPS coordinates of the grid intersections, hover the cursor over the
intersection. The GPS coordinates of that location are shown at the bottom of the
screen (Fig. 30). Record these to bring along for field work.

Figure 30: Google Earth GPS coordinates at the bottom center of the window

Appendix B. Using MATLAB to Create Profiles from YSI Castaway

TM -

CTD

The YSI CastAwayTM - CTD software provides a useful interface to import data from the
CTD and review it quickly, but it cannot produce a profile showing spatial variations in the
parameter of interest. To obtain these profiles, such as those shown in Fig. 31, programs have
been written in MATLAB.
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Figure 31: Example of salinity profiles created through MATLAB
Set Up
1. Create a folder devoted to CTD programs and data.
2. Open MATLAB and set the folder created in step 1 as the "Current Folder." To do this,
locate the text box in the window on the left side of the screen (see Fig. 32). Use the drop
down menu and the folder icon to locate the new folder. In Fig. 32, the folder named
"CTD" was created and then selected as the current folder.

D NameA
getCoords.m
getParam.m
meshArea.m
Profile.m
profileOverlay.m
ProfileSfice.m

verticalProfile.m

Figure 32: "Current Folder" setting in MATLAB window. It can be changed by clicking
on either the magnifying glass or the folder up icons to the right of the folder name.
3. Seven different scripts need to be created in the current folder. The code for these files is
given in Appendix C. The seven functions are separated by solid lines.
a. First, click on the New Script icon

_

or File > New > Script. An editor

window will open. Copy and paste the code for the first function into this
window.
b. Save the code by clicking on the Save icon or File > Save.
c. The name of the file to be saved should default to the function name (found in the
first line of the code). Check that this is true, then confirm the save file and close
the editor window
d. Repeat this for remaining functions.
At the end of this step, the directory should look like that shown in Fig. 32.
Exporting Files
Using the YSI CastAwayTM - CTD software, locate and select the files to be included in the
profile. For help using the YSI software, refer to the CastAwayTM - CTD User's Manual, found
by clicking the question mark at the top of the screen.
Export the MATLAB format of these files to the folder created in step 1 by using the Export
Files button in the task section in the menu bar at the top of the screen.
The exported files may need to be unzipped. This can be done by right-clicking on the zipped
folder and selecting "Extract All". Consult the CastAwayTM - CTD User's Manual, "5.6.2.
Export Files" on page 57 should any difficulties arise during this step.
The folder designated for CTD profiling can contain multiple folders devoted to different
projects. The data points in each different area to be profiled should be exported together in a
folder for that area. For the work done herein, two different areas were profiled: a section of
Quonochontaug Pond in Rhode Island and a cove in Chrysochou Bay in Cyprus. Using the YSI
software, all of the data to be included in the Quonochontaug Pond profile was exported to a
folder named "Quonny Pond" within the CTD folder. Then the data to be included in the

Chrysochou Bay profile was exported to a folder named "Cove" within the CTD folder.
Additional folders were made containing information regarding the perimeters of these areas.
Fig. 33 shows the final structure of the designated CTD folder for these projects.
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Figure 33: The folder created for CTD profiling includes all seven functions and the data
to be profiled from Quonochontaug Pond as well as a cove in Chrysochou Bay. Each
group of data to be profiled requires its own folder, as well as an optional folder defining
the perimeter of that profile.
Defining the Perimeter
In some cases, it is beneficial to define the external perimeter of the area to be profiled. If
no perimeter is defined, MATLAB will create a default perimeter that may or may not be
appropriate for the case at hand. Fig. 34 shows the temperature profile of Quonochontaug Pond
a) with a perimeter specified by the user and b) without a specified perimeter.
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Figure 34: Temperature profiles of Quonochontaug Pond made from the same data a) with
perimeter specified by the user and b) without perimeter specified by the user
If it is deemed necessary to specify the perimeter, use the YSI software to select only
those measurements that define the perimeter. Export these to the CTD folder in the same
manner as the data files were exported. Only the GPS coordinates of these measurements will be
used, so it is not necessary to export all of the data contained within these files.
Given a set of points, there are multiple possibilities for the order in which they could be
connected, resulting in different shapes. Consequently, it is necessary that the user organize the

files in the folder in the order one would come across the measurements if he or she were to
traverse the perimeter in a single direction. By default, the exported files will be organized by
their names, which are given by the serial number of the device, the date on which the
measurement was taken, and the time at which the measurement was taken.
Ordering Files Correctly
1. Using the YSI software, make a list of the points that were exported to the perimeter folder.
Pick a starting point and travel around the perimeter either clockwise or counterclockwise,
making a numbered list of the cast times for each measurement in order. Note that while the
YSI software displays local cast times, the times used in the filenames are in UTC. It may be
helpful to include these as well. A sample list may look like this:
#

Local Time

UTC

1

16:30:38

20:30:38

2

16:32:47

20:32:47

3

16:33:32

20:33:32

4

16:34:29

20:34:29

5

16:35:11

20:35:11

2. In the folder of exported perimeter data, use the filename of each data point to determine
what number file it should be in the list. For example, using the data points listed in step 1,
the first file in the folder should be the one that was taken at 20:30:38 UTC. This means the
filename would end in 203038.
3. Change the filename of each file so that the order of files will match the perimeter order. The
standard filename of exported data is a series of numbers of the form
SerialNumberCastDateCastTime.mat. Thus the casts are sorted chronologically by default
file name. However, a number can be added to the front of each file name to adjust the order.
The full name of the file mentioned in step 2 is 11 B 100023_20110626_203038.mat. By
changing the name to 01_1 lB 100023_20110626_203038.mat and changing all other file
names in the folder to follow suit, the files can be reordered as desired.
4. When all filenames in the folder have been changed, type (do not copy and paste, as this will
change the format) the following lines into the MATLAB command window:
>>

[x, y] = getCoords('Quonny Pond Perimeter');

>> plot(x,y);

I

In this case the folder to which the CTD perimeter data was exported was named "Quonny
Pond Perimeter". Change this to reflect the proper folder name. This will plot the perimeter in
the order the files appear, as shown on the left below. If the files are not properly ordered, the
result will appear more like the plot on the right of Fig. 35.
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Figure 35: Results of plotting the perimeter when files are correctly ordered (left) and
incorrectly ordered (right)
The plot will show a small gap between the first and last data point. When used to create
profiles, the program will close the perimeter. If the perimeter does not appear as expected,
double-check the order of the filenames in the perimeter folder.
Creating Horizontal Profiles
At this point, the "current folder" in MATLAB should contain seven functions, a folder
containing the data to profile, and (optionally) a folder containing the perimeter data. Everything
is now set up to begin creating profiles.
All horizontal profiles should be created by calling the Profile function, which in turn
calls several of the other functions. Unless debugging, only Profile, verticalProfile and
profileOverlay should ever be used.
The Profile function is called by typing the following into the MATLAB Command
Window:
>> Profile (DataFolderName,PerimDataFolderName,Param,depths,minval,maxval);

The input arguments each need to be changed to suit the desired profile. Descriptions of the
input arguments and their possible values are:
e

DataFolderName - This is the name of the folder containing the data to be profiled.
MATLAB expects a string for a folder name, so it must be enclosed by apostrophes. For
example, if the folder was named CTD Data, 'CTD Data' would be typed in place of
DataFolderName when calling profile. The folder name must be spelled exactly as it
appears in the current folder. It is not case-sensitive. DataFolderName is required.

"

PerimDataFolderName - This is the name of the folder containing the perimeter data.
The same rules apply for entering this as for DataFolderName. If the folder containing
the perimeter data was named CTD Perimeter, 'CTD Perimeter' would be typed in the
spot for PerimDataFolderName. PerimDataFolderName is an optional input; to use a
default perimeter created by MATLAB to fit the data, use an empty matrix (i.e. type: [])
in as the argument for PerimDataFolderName.

*

Param - This tells the program what parameter it should profile. The options for Param
are: 'Salinity', 'Temperature', 'Specific_conductance', 'Conductivity', 'Pressure',
'Sound_velocity', and 'Density'. These must be typed in exactly as shown here; improper
capitalization or spelling will result in an error message from MATLAB.

* Depths - This is a vector that tells the program how many horizontal slices to show and
at what depths (in meters). For example, if [2,4,6,8] were entered in the depths field, four
profiles would be shown: horizontal cross sections at two meters, four meters, six
meters, and eight meters deep. The charts in the YSI software can be used to determine
logical depths at which to make profiles. Due to imprecision in data at the water surface,
the minimum depth at which an accurate profile can be made is approximately 0.2
meters. Some casts may record measurements deeper than other casts. If the depth of a
profile exceeds the depth of the cast at that particular point, the black dot marking the
cast location will be visible, but the area around it may be white instead of colored like
the rest of the profile. If point measurements are to be used to create a profile rather than
casts, an empty matrix ( [ ] ) should be used as the depths argument.
*

Minval and Maxval - These are optional values that are entered to manually set the color
scale for the profiles. The program default is to automatically set the scale with the
minimum measured value at one end of the spectrum and the maximum measured value
at the other. If preferred, enter a number for Minval and Maxval and these will become
the boundaries for the color scale.

Using all of this information, in order to obtain a salinity profile at a depth of 1, 2 and 3
meters with the data contained in a folder called "Cove" and the perimeter contained in a folder
called "Cove Perimeter", one would type the following into the MATLAB command window
with the current folder set to the folder containing all of the functions and the data:
>>Profile('Cove','Cove Perimeter','Salinity',[1,2,3]);

This would result in the plots shown in Fig. 36, which are the same as those shown in
Fig. 31.
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Figure 36: Salinity profiles at depths of 1 m, 2 m and 3 m created using the Profile
ftmction in MATLAB.
The program may take a few minutes to produce the profiles. As long as the word "Busy"
is displayed in the lower left-hand corner of the MATLAB window (next to the MATLAB start
menu), the program is still working. If the program is taking too long, type Ctrl + C to terminate
the program and adjust the mesh size by opening the ProfileSlice program in the MATLAB
editor and increasing the variable n for a more coarse mesh.
While all plot formats were made to fit as many situations as possible, in some cases the
size, shape, or format may not be suitable. These can be adjusted by opening the Edit Plot option
on the Tools menu of the plot window. Further information can be found in the MATLAB Help
window.

Creating Google Earth Overlays of Horizontal Profiles
The program profileOverlay creates a .kml file that can be opened in Google Earth to
display a horizontal slice of the profile, as shown in Fig. 37. It uses the GPS data from the CTD
to align the profile with the map in Google Earth.

Figure 37: Horizontal salinity profile of Quonochontaug Pond, Rhode Island displayed
as an overlay in Google Earth as created with the profileOverlay function. The GPS data
recorded by the CTD are used to align the profile in the proper location. Google Earth
screenshot: C 2012 Google.
In addition to creating the .kml file, profileOverlay also saves the profile as a rectangular
image with all pixels not included in the profile set to transparent. The .kml file created includes
a reference to the file name of that rectangular image and the GPS coordinates for the four
corners of that image. Note that the scale correlating colors in the profile to values is not
included in the overlay. Calling profileOverlay also displays the profile in a MATLAB figure;
this can be saved and cropped to include just the color scale and included with the Google Earth
overlay. The results of using profileOverlay are shown in Fig. 38.

Figure 38: Calling profileOverlay shows the profile slice as a MATLAB figure (left),
saves the figure as a rectangular image with all pixels outside of the profile set to
transparent (center), and creates a .kml file containing the image file name and the GPS
coordinates of its four corners (right). Google Earth screenshot: C 2012 Google.
The profileOverlay function is called by typing the following into the MATLAB command
window:
>> profileOverlay(DataFolderName,PerimDataFolderName,Param,depth,
PicFileName,kmlFileName,minval,maxval);

The only input for the profileOverlay function that is not used in the Profile function is
FileName. FileName specifies the name to give to the saved image of the profile and the .kml
file. As with DataFolderName and PerimDataFolderName, FileName must be a string, i.e.
enclosed by apostrophes. FileName should not include a file extension, such as .jpg, .xml, etc.,
as this will be assigned by the function. After running profileOverlay, two new files will appear
in the current folder: FileName.png and FileName.kml. FileName.png is a picture that can be
opened with any program capable of showing images. FileName.kml contains a reference to
FileName.png and the GPS coordinates of the four corners at which the picture should be
displayed. If a file called either FileName.png or FileName.kml already exists in the current
folder, it will be replaced with the new picture or .kml file without warning.
The input parameter depth in this case is either a single value or an empty matrix, []
When obtaining profiles from a series of CTD casts, a single value should be given that
represents the depth (in meters) of the horizontal slice that will be used as the overlay image in
Google Earth. For instance, if the number 1.5 was entered as the depth, the resulting .kml file
would show the horizontal profile at 1.5 m deep aligned on the Google Earth map. Remember
that the CTD data is not valid shallower than 20 cm, so the minimum input for depth should be
0.2. If a series of CTD point measurements are to be profiled, the input for depth should be an
empty matrix. All other input parameters are as defined above in the description of using the
Profile function.

For example, in order to create a .kml file called QPond.kml that displays the salinity profile
obtained from point measurements at Quonochontaug Pond, Rhode Island, as shown in Fig. 37,
one would type the following into the MATLAB command window:
>> profileOverlay('Quonny

Pond','Quonny Pond Perimeter','Salinity',

[],'QPond');

where 'Quonny Pond' and 'Quonny Pond Perimeter' are the names of the folders containing
the CTD data and perimeter data respectively. After calling this function, the folder designated
to analyzing CTD data could look like that shown in Fig. 39.
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Figure 39: Current folder in MATLAB as it appears after using the profileOverlay
function to create a .kml file that displays the salinity profile of Quonochontaug Pond in
Google Earth. The files QPond.kml and QPond.png were both created by the function.
Once the .kml file has been created, it can be opened in one of two ways. Either navigate to
its location on the hard drive and double click the file name, or type:

>> winopen('QPond.kml');

into the MATLAB command window on a windows computer. Google Earth will then open (if
not already opened) and it will automatically zoom to the location of the profile that will be
displayed.

Creating Vertical Profiles
Creating vertical profiles is somewhat less useful than horizontal profiles since the casts
need to be done in a relatively straight line to create a meaningful profile. An example of when a
vertical profile might be of use is when casts are performed from a bridge or a dock. The result is
shown in Fig. 40, which shows temperature measurements taken from the sidewalk along the
Charles River in Cambridge, MA. The high temperatures are caused by discharge from the
Kendall Mirant Power Plant, which occurs at a distance of approximately 23 m along the
walkway.
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Figure 40: Vertical profile of temperature measured from walkway along Charles River
in Cambridge, MA.
As with creating horizontal profiles, the CTD data must be exported into the folder that
contains the profiling functions. Create a single folder that has all of the data for the vertical
profile. For the most meaningful results, the locations of these casts should lie on a straight line
as do the casts used for the profile in Fig. 40. These casts are shown in Fig. 41.

Figure 41: Locations of casts from Charles River, as shown in YSI software, used to
create profile shown in Fig. 40.
Because the cast files will likely not be in a perfectly straight line and it is difficult to go
from two-axis GPS coordinates to a single line accurately, the vertical profile function needs
some input as to how the measurements are spaced. The files containing the data for the vertical
profile must either be:
a) ordered as they should appear along the x-axis of the resulting graph, from left to
right. That is, the first file will have an x-coordinate of 1, the second will be 2, the
third, 3, and so on
-ORb) accompanied by a matrix (called Xpos, for x positions) specifying the x-coordinates
of the files in the order the files appear in the folder. That is, if there are three files to
be included in the vertical profile, and Xpos is given by [5, 2, 7], the first file will be
assigned an x-coordinate of 5, the second will be assigned an x-coordinate of 2, and
the third an x-coordinate of 7.
Once the data has been exported to MATLAB and ordered appropriately, vertical profiles
such as these are created by calling the verticalProfile function as follows:
>> verticalProfile (FolderName,Param,XPos);

This function is very similar to the Profile function previously discussed. It has two
required inputs and one optional input as described below.
0 FolderName - This is the name of the folder containing the CTD data. As with the input
folder names used with the Profile function, this must be entered as a string (i.e. between
apostrophes) with correct spelling. FolderName is not case-sensitive.

0

Param - Exactly the same as the Param input for profile, this argument tells the program
what parameter to profile. Options are 'Salinity', 'Temperature', 'Specificconductance',
'Conductivity', 'Pressure', 'Soundvelocity', and 'Density'. These must be entered
exactly as shown here; improper capitalization or spelling will result in an error message
from MATLAB.

* XPos - This input is unique to verticalProfile. It specifies the x-coordinates of the
measurements. For instance, with the vertical profile from the Charles River, casts were
performed every five meters, starting at an arbitrarily defined origin and extending 90 m.
Thus the input for XPos was [0, 5, 10, 15, 20, 25, 30, 35, 40, 45, 50, 55, 60, 65, 70, 75,
80, 85, 90]. If XPos is left blank or filled by an empty matrix, the program will default to
using integers as the x-coordinate for the data (i.e. 1, 2, 3, etc.).
The profile shown in Fig. 40 was created with the following commands:
>> XPos = [0,5,10,15,20,25,30,35,40,45,50,55,60,65,70,75,80,85,90]);
>> verticalProfile('Charles River Data','Salinity',XPos);

As with the horizontal profiles, the vertical profile program may take a few minutes to
finish. If need be, type Ctrl + C to terminate the program. Then open the verticalProfile program
and increase the maximum mesh size, n, to make the mesh coarser.
Once the profile has been made, the plot can be formatted (axis labels adjusted, resized,
titles added, position of color bar changed, etc.) by opening Tools > Edit Plot in the plot
window. Further information on formatting the plot area can be found in the MATLAB Help
window.

Appendix C. MATLAB Functions for YSI CastAway

TM - CTD

Data Analysis

Function [] =
Profile (DataFolderName,PerimDataFolderName,Param,depths,minval,maxval)
%Produces and displays cross-sectional profile at multiple depths
%DataFoldername is the name of the folder containing the measurements of
%interest. Must be a folder in the same directory as this m-file.
%PerimDataFoldername is the name of the folder containing the ordered
%measurements that identify the perimeter of the area of interest. If
is used for PerimDataFoldername, program will make a default perimeter
%[]
%that includes all points in DataFoldername
%Param is the parameter to profile. Options for Param are limited to
%'Salinity', 'Temperature', 'Specific conductance', 'Conductivity',
% 'Pressure', 'Sound-velocity', and 'Density'
%depths is an array containing the depths in meters at which a horizontal
%profile slice is desired. All depths should be positive values. If [] is
%entered for depths, program will provide a profile of all point
%measurements in the data folder.
%minval and maxval are the minimum and maximum values represented in the
%color scale. If these arguments are not included, they automatically get
%set to the minimum and maximum value measured by the CTD.
cmin = 0;
cmax = 0;
AllVals =

[];

n=length(depths);
%if the Param field is not a recognized parameter, exit program
&&
-strcmp(Param,'Temperature')
&&
(-strcmp(Param,'Salinty')
if
-strcmp(Param,
&&
'Specific-conductance')
~strcmp(Param,
strcmp(Param,
&&
'Pressure')
strcmp(Param,
&&
'Conductivity')
'Density'))
strcmp(Param,
&&
'Sound velocity')
Please try again,
not recognized.
error('The entered parameter is
Conductivity,
Specific conductance,
Temperature,
Salinity,
using
Pressure, Sound-velocity, or Density.');
end
%determine number of rows and columns of plots if max number of rows is 3
row =
col =

0;
0;

if n==0
col = 1;
row = 1;

elseif n<=3
col=n;
row=1;

else
row=3;
col=ceil(n/3);
end
%Determine minimum and maximum values of colorscale, either through input
%arguments or by finding the minimum and maximum measured values
if nargin == 6
cmin = minval;
cmax = maxval;

else
if n>O
for j=l:n
AllVals = [AllVals getParam(DataFolderName,depths(j),Param)];
end
else
AllVals = getParam(DataFolderName,depths,Param);
end
cmin = min(min(AllVals));
cmax = max(max(AllVals));
end
%display the minimum and maximum values measured by the CTD
%disp([cmin cmax]);
% if casts are being profiled, index through subplots and call
% ProfileSlice
% at the specified depths to produce the plots
if n>O
for k=l:n
pos=k; %plots increasing depth left to right
%if instead plots are desired to increase in depth top to bottom,
%uncomment the following block of code.
%if rem(k,3)==l
%
pos=ceil(k/3);
%elseif rem(k,3)==2
%
pos=ceil(k/3)+4;
% else
%
pos=ceil(k/3)+8;
% end
subplot(row,col,pos);
[-,>,Xmin,Xmax,Ymin,Ymax]=ProfileSlice(DataFolderName,
PerimDataFolderName,Param,depths(k));
%format subplot
caxis([cmin,cmax]);
axis equal;
axis([Xmin-.00025,Xmax+.00025,Ymin-.00025,Ymax+.00025]);
title(['Depth = ',num2str(depths(k)), 'm'])
end
else

%Otherwise, use ProfileSlice to profile point measurements

ProfileSlice (DataFolderName, PerimDataFolderName, Param, depths);
caxis([cmin,cmax]);
axis equal;
title([Param, ' Profile']);
end
%Format chart area
axes('OuterPosition', [0.5 0.05 0.5 0.9],
c=colorbar ('FontSize',12);
set(get(c,'child'),'YData',[cmin,cmax]);
set(c,'YLim', [cmin,cmax]);

'Visible',

'off');

%Label colorbar according to variable profiled
if strcmpi(Param,'Salinity')
xlabel(c, 'Salinity [PSS]');
elseif strcmpi(Param, 'Specific conductance')
xlabel(c, 'Specific Conductance [uS/cm]');
elseif strcmpi(Param, 'Conductivity')
xlabel(c, 'Conductivity [uS/cm]');
elseif strcmpi(Param, 'Temperature')
xlabel(c, 'Temperature [degC]');
elseif strcmpi(Param, 'Pressure')
xlabel(c, 'Pressure [dbar]');
elseif strcmpi(Param, 'Sound velocity')
xlabel(c, 'Sound Velocity [m/s]');
elseif strcmpi(Param, 'Density')
xlabel(c,

'Density [kg/m^3]');

end

function [] = profileOverlay(DataFolderName,PerimFoldername, Param, depth,
FileName, minval, maxval)
%
%
%
%
%

Given DataFoldername, which contains all CTD data files, and
PerimFoldername, which contains the perimeter CTD data files (in order),
profileOverlay creates a .kml file, saved at FileName.kml, which can be
opened in Google Earth to show the profile of the parameter specified by
Param at the specified depth at the correct location.

% Also creates an image at FileName.png which is associated with the
% file, and displays the specified profile as a MATLAB figure.
cmin =
cmax =

.kml

0;
0;

PicFileName = [FileName
kmlFileName = [FileName
AllVals = [];
n=length(depth);

'.png'];
'.kml'];

%if the Param field is not a recognized parameter, exit program
if (-strcmp(depth,'Salinty') && -strcmp(depth,'Temperature') &&
~strcmp(depth, 'Specific-conductance') && ~strcmp(depth, 'Conductivity') &&

strcmp(depth, 'Pressure') && strcmp(depth, 'Soundvelocity') && strcmp(depth,
'Density'))
error('The entered parameter is not recognized. Please try again, using
Salinity, Temperature, Specificconductance, Conductivity, Pressure,
Soundvelocity, or Density.');
end
%Determine minimum and maximum values of colorscale, either through input
%arguments or by finding the minimum and maximum measured values
if nargin == 7
cmin = minval;
cmax = maxval;

else
if n>0
for j=l:n
AllVals = [AllVals getParam(DataFolderName,depth(j),Param)];
end
else
AllVals = getParam(DataFolderName,depth,Param);
end
cmin = min(min(AllVals));
cmax = max(max(AllVals));
end
%Find coordinates of all data points
[Xmeas,Ymeas] = getCoords(DataFolderName,depth);
%Create mesh over area of interest to determine locations at which to
%interpolate data.
if length(PerimFoldername)>0
[Xperim,Yperim] = getCoords(PerimFoldername,depth);
%Close Perimeter Polygon
Xperim = [Xperim;Xperim(l)];
Yperim = [Yperim;Yperim(l)];
%Define fineness of mesh; maximum step size in decimals of GPS
% coordinates.
n=. 00001;
%Call meshArea to fill in perimeter with points at which salinity will be
% interpolated
[Xi,Yi,Xall,Yall,Xmin,Xmax,Ymin,Ymax] = meshArea(Xperim,Yperim,n,l);
else

%No Perimeter is specified; Create default mesh covering entire area
specified by measurements in data folder
Xperim = Xmeas;
Yperim = Ymeas;

%Close Perimeter Polygon
Xperim = [Xperim;Xperim(l)];
Yperim = [Yperim;Yperim(l)];
%Define fineness of mesh; maximum step size in decimals of GPS

% coordinates.
n=.00001;
%Fill in perimeter with points at which salinity will be interpolated
[Xi,Yi,Xall,Yall) = meshArea(Xperim,Yperim,n,O);
end

%Extract measurements from data folder
Smeas = getParam(DataFolderName,depth,Param);
%Interpolate measurements made at (Xmeas,Ymeas)to locations(Xi,Yi)
Si=griddata(Xmeas,Ymeas,Smeas,Xi,Yi);
%Find gps coordinates of corners
[m n]

=

size(Xall);

%Put coordinates into format expected by .kml file.
coordStr = [num2str(Xall(1,1)) ','
num2str(Yall(l,l))
'
' num2str(Xall(1,n))
',I' num2str(Yall(1,n)) ' ' num2str (Xall(m,n)) ' 'num2str(Yall(m,n))
' '
num2str(Xall(m,1))
','
num2str(Yall(m,1))];

h=figure;
%Create colored contour plot
[-,ch] = contourf(Xall,YallSi,15);
%removes contour lines, leaving only colors
set(ch,'edgecolor','none');
hold on;
%Draw perimeter on plot (useful for checking perimeter folder)
%plot(Xperim,Yperim,Xi,Yi);
%Plots measurement locations as black dots
plot(Xmeas,Ymeas, 'k.');
%Formats axes
axis equal;
axis([Xmin-.00025,Xmax+.00025,Ymin-.00025,Ymax+.00025]);
axis off;
% Records MATLAB figure as an image object
I=getframe();
f =

frame2im(I);

%make alpha matrix to make background of saved image transparent
s =

size(f);

alphadata = zeros(s(l), s(2));
for i=l:s(l)
for j=1:s(2)
if (f(i,j,1)~=204 1| f(i,j,2)~=204
alphadata(i,j)=1;
end
end
end

If(i,j,3)

-=204)

%Save image as FileName.png, a rectangular image with transparent
%background
imwrite(f,PicFileName,'Alpha',alphadata);
% Format MATLAB figure
axis on;
c=colorbar ('FontSize',12);
caxis([cmin,cmax]);
axes('OuterPosition', [0.5 0.05 0.5 0.9],
set(get(c,'child'),'YData', [cmin,cmax]);
set(c,'YLim', [cmin,cmax]);

'Visible',

'off');

%Label colorbar according to variable profiled
if strcmpi(Param,'Salinity')
xlabel(c,'Salinity [PSS]');
elseif strcmpi(Param, 'Specific conductance')
xlabel(c, 'Specific Conductance [uS/cm]');
elseif strcmpi(Param, 'Conductivity')
xlabel(c, 'Conductivity [uS/cm]');
elseif strcmpi(Param, 'Temperature')
xlabel(c, 'Temperature [degC]');
elseif strcmpi(Param, 'Pressure')
xlabel(c, 'Pressure [dbar]');
elseif strcmpi(Param, 'Soundvelocity')
xlabel(c, 'Sound Velocity [m/s]');
elseif strcmpi(Param, 'Density')
xlabel(c,

'Density [kg/m^3]');

end
hold off;
%The rest of the code deals with the creation of the .kml file, which is a
%specialized form of a .xml file. This section will be difficult to
%understand without some prior knowledge of node structures and .xml files.

%Create DOMNode from which .kml file will be made
docNode = com.mathworks.xml.XMLUtils.createDocument('kml');
% Set attributes necessary for .kml file (as opposed to .xml files)
kml = docNode.getDocumentElement;
kml.setAttribute('xmlns','http://www.opengis.net/kml/2.2');
kml.setAttribute('xmlns:gx', 'http://www.google.com/kml/ext/2.2');
%Create 'GroundOverlay' element
overlay = docNode.createElement('GroundOverlay');
% Give the overlay a name. String in second line within createTextNode()
% can be changed as desired.
name = docNode.createElement('name');

name.appendChild(docNode.createTextNode([Param
Overlay']));
overlay.appendChild(name);

'

Profile Google Earth

%Give overlay a description. String in second line within createTextNode()
% can be changed as desired.
descript = docNode.createElement('description');
descript.appendChild(docNode.createTextNode(['Overlay of ' Param ' profile
obtained through data measured with the YSI CTD.']));
overlay.appendChild(descript);
% Create Icon element
image = docNode.createElement('Icon');
% Create element specifying the picture of the profile as the image to be
displayed.
href =

docNode.createElement('href');

href.appendChild(docNode.createTextNode(PicFileName));
image.appendChild(href);
overlay.appendChild(image);
%Define quadrilateral of GPS coordinates representing the locations of the
four corners of
%the image to be displayed.
quad = docNode.createElement('gx:LatLonQuad');
coords = docNode.createElement('coordinates');
coords.appendChild(docNode.createTextNode(coordStr));
quad.appendChild(coords);
overlay.appendChild(quad);
% Append the 'GroundOverlay' element to the root node as a child.
kml.appendChild(overlay);
%Save .kml file defined by DOMNode.
xmlwrite(kmlFileName, docNode);

function

[]

= verticalProfile(FolderName,Param,Xpos)

%Given a FolderName that contains ctd casts, the desired parameter, and
%distance along horizontal axis (optional), verticalProfile creates a
%colored contour map of measurements and interpolated values over a
%vertical slice of the body of water
%The files in FolderName need to be in order; ie the first file in the
%folder should be taken at one end of the horizontal axis and each
%consecutive file should progress in the same direction to the final file
%at the opposite end of the axis.
%Xpos is an optional variable; if left blank, the units on the horizontal
%axis represent the number of the file (ie 1,2,3...). If included, Xpos
%should contain a vector of the relative positions of the measurements.
% For example, if a measurement was taken every 5 meters with the first

%measurement defined as the origin, Xpos would be

[0 5 10 15

... ]

%Create list of filenames in folder for indexing
list=what(FolderName);
numFiles=length(list.mat);
%Check that Xpos (if given) matches number of data files
if nargin == 3 && numFiles ~ length(Xpos) && length(Xpos)>0
error('Number of positions given needs to match number of casts');
end
%Initialize XBoundaries and DepthBoundaries. These will represent the
%coordinates of the perimeter of the area in which measurements were
%taken.
XBoundaries =zeros(numFiles+2,1);
DepthBoundaries =zeros(numFiles+2,1);
%XData and DepthData will contain coordinates of meshed area within
%perimeter; ParamData will contain the value of the measurements
%interpolate at each (XData, DepthData)
XData = [];
DepthData =
ParamData =

[];

%For each file, add (x position, max depth) to the boundary vectors and
%each measurement and location to the data vectors.
for i=l:numFiles
FileName=strcat(FolderName,'\',char(list.mat(i)));
Depths =getfield(load(FileName, 'Depth'),'Depth');
Measurements = getfield(load(FileName, Param), Param);
DepthBoundaries(i)= -max(Depths);
if nargin<3 11 length(Xpos)==0
XBoundaries(i)=i;
XData((length(XData)+1):(length(XData)+length(Depths)))=i;
else
XBoundaries(i)=Xpos(i);
XData((length(XData)+1):(length(XData)+length(Depths)))=Xpos(i);
end
DepthData = [DepthData; -Depths];
ParamData = [ParamData; Measurements];
end
%transpose XData to fit expectations of format elsewhere in code
XData=XData';
% Boundary vectors now contain coordinates along the bottom of the
% profile.
%Add upper right and upper left coordinates to boundary vectors.
if nargin == 2

|1

length(Xpos)==0

XBoundaries( numFiles+l)= numFiles +1;
XBoundaries( numFiles+2) = 1;
else
XBoundaries( numFiles+1 ) = Xpos(length(Xpos));
XBoundaries(numFiles + 2) = Xpos(1);

end
DepthBoundaries(numFiles + 1) = 0;
DepthBoundaries(numFiles + 2) = 0;
%Close boundary polygons
XBoundaries = [XBoundaries; XBoundaries(l)];
DepthBoundaries = [DepthBoundaries; DepthBoundaries (1)];
%Display perimeter for sake of debugging
%plot(PosBoundaries,DepthBoundaries);
%create mesh within area of measurement to define locations at which
%variable of interest should be interpolated
[Xgrid,Ygrid,Xall,Yall]= meshArea(XBoundaries,DepthBoundaries,0.01,0);
%interpolate variable of interest
Interp = griddata(XData, DepthData, ParamData, Xgrid, Ygrid);
%plot profile
[-,ch]=contourf(Xall,Yall,Interp,15);

%set(ch,'edgecolor','none');

%removes contour lines

(optional)

%Create and label colorbar
c=colorbar ('FontSize',12);
%Label colorbar according to variable profiled
if strcmpi(Param,'Salinity')
xlabel(c,'Salinity [PSS]');
elseif strcmpi(Param, 'Specific conductance')
xlabel(c, 'Specific Conductance [uS/cm]');
elseif strcmpi(Param, 'Conductivity')
xlabel(c, 'Conductivity [uS/cm]');
elseif strcmpi(Param, 'Temperature')
xlabel(c, 'Temperature [degC]');
elseif strcmpi(Param, 'Pressure')
xlabel(c, 'Pressure
[dbar] ');
elseif strcmpi(Param, 'Sound velocity')
xlabel(c, 'Sound Velocity [m/s]');
elseif strcmpi(Param, 'Density')
xlabel(c,

'Density

[kg/m^3]');

end
ylabel('Depth

function

[m]');

[Xi,Yi,Si,Xmin,Xmax,Ymin,Ymax] =
ProfileSlice (DataFoldername,PerimFoldername, Param, depth)

% Given DataFoldername, which contains all CTD data files, and

%
%
%
%

PerimFoldername, which contains the perimeter CTD data files
ProfileSlice returns Si, the measurements specified by Param
interpolated at positions Xi and
Yi at depth based on CTD data.

(in order),

%if the Param field is not a recognized parameter, exit program
if
(strcmp(depth,'Salinty')
&&
-strcmp(depth, 'Temperature')
&&
-strcmp(depth,
'Specificconductance')
&&
-strcmp(depth,
'Conductivity')
&& strcmp(depth,
'Pressure')
&& strcmp(depth,
'Soundvelocity') && strcmp(depth, 'Density'))
error('The entered parameter is
not recognized.
Please try again,
using
Salinity,
Temperature,
Specific-conductance,
Conductivity, Pressure, Sound-velocity, or Density.');
end
%Find coordinates of all data points and of perimeter
[Xmeas,Ymeas] = getCoords(DataFoldername,depth);

%Create mesh over area of interest to determine locations at which to
%interpolate data.
if length(PerimFoldername)>0
[Xperim,Yperim] = getCoords(PerimFoldername);
%Close Perimeter Polygon
Xperim = [Xperim;Xperim(l)];
Yperim = [Yperim;Yperim(l)];
%Define fineness of mesh; maximum step size in decimals of GPS
% coordinates.
n=.00001;
%Call meshArea to fill in perimeter with points at which salinity will
% be interpolated
[Xi,Yi,Xall,Yall,Xmin,Xmax,Ymin,Ymax] = meshArea(Xperim,Yperim,n,1);
else

%No Perimeter is specified; Create default mesh covering entire
%area specified by measurements in data folder
Xperim = Xmeas;
Yperim = Ymeas;

%Close Perimeter Polygon
Xperim = [Xperim;Xperim(l)];
Yperim = [Yperim;Yperim(l)];
%Define fineness of mesh; maximum step size in decimals of GPS
%coordinates.
n=.00001;
%Fill in perimeter with points at which salinity will be interpolated
[Xi,Yi,Xall,Yall,Xmin,Xmax,Ymin,Ymax] = meshArea(Xperim,Yperim,n,0);
end

%Extract measurements from data folder
Smeas = getParam(DataFoldername,depth,Param);
%Interpolate measurements made at (Xmeas,Ymeas)to locations(Xi,Yi)
Si=griddata(Xmeas,Ymeas,Smeas,Xi,Yi);
%Create colored contour plot
[-,ch] = contourf(Xall,Yall,Si,15);
%removes contour lines, leaving only colors
set(ch,'edgecolor','none');

hold on;
%Draw perimeter on plot (useful for checking perimeter folder)
%plot(Xperim,Yperim,Xi,Yi);
%Plots measurement locations as black dots
plot(Xmeas,Ymeas,'k.');

function

[Xgrid,Ygrid,Xall,Yall,Xmin,Xmax,Ymin,Ymax]
meshArea (X, Y,n, perim)

-

%This function takes a polygon with vertices given by X and Y and fills it
%in with a mesh of points no more than n distance apart.
%perim can either be 1, indicating that coordinates in x and y specify an
%ordered perimeter, or 0, indicating that x and y are a cloud of data
%points
%Xgrid and Ygrid give the coordinates within the polygon.
%Xall and Yall give the coordinates of a meshed rectangle that entirely
%contains the specified polygon.
%Find extremes of polygon or data cloud
Xmax=max(X);
Xmin=min(X);
Ymax=max(Y);
Ymin=min(Y);
%find the number of steps along each axis required to meet maximum step
%size
nX=ceil((Xmax-Xmin)/n);
nY=ceil((Ymax-Ymin)/n);
%define x and y axes that cover entire polygon + margin

xAxis=linspace(Xmin-.00025,Xmax+.00025,nX);
yAxis=linspace(Ymin-.00025,Ymax+.00025,nY);
%Fill in rectangular mesh across entire region defined by axes
[Xgrid Ygrid]=meshgrid(xAxis,yAxis);
Xall=Xgrid;
Yall=Ygrid;
%If a polygonal perimeter has been specified, remove points from
%rectangular mesh that lie outside polygon
if perim
[in on]=inpolygon(Xgrid,Ygrid,X,Y);
[r,c]=size(Xgrid);
for i=l:r
for j=l:c
if ~in(i,j) && ~on(i,j)
Xgrid(i,j)=NaN;
Ygrid(i,j)=NaN;
end
end
end
end

function

[x y]= getCoords(foldername,depths)

% Returns the starting GPS coordinates of each CTD datapoint in foldername
% If depths contains any elements, [x y] is coordinates of casts only.
% If depths is empty, [1, [x y] is coordinates of point measurements only
%Find number of .mat files in foldername
list=what(foldername);
numFiles=length(list.mat);
x=[];
y=[];
k=1;
%For debugging, use this line to make sure files are in correct order in
%foldername (particularly useful for perimeter)
%files=list.mat

%for each file, get the longitude and latitude and add them to x and y
if nargin ==1
%use all data points
for i=l:numFiles
filename=strcat(foldername,'\',char(list.mat(i)));
x(k)=getfield(load(filename, 'LongitudeStart'), 'LongitudeStart');
y(k)=getfield(load(filename,'LatitudeStart'),'LatitudeStart');
k=k+l;
end

elseif length(depths)==0

%point measurements only

for i=l:numFiles
filename=strcat(foldername,'\',char(list.mat(i)));
if
(getfield(load(filename,'IsPointMeasurement'),'IsPointMeasurement
') && getfield(load(filename, 'IsInvalid'), 'IsInvalid'))
x(k)=getfield(load(filename,'LongitudeStart'),'LongitudeStart');
y(k)=getfield(load(filename,'LatitudeStart'),'LatitudeStart');
k=k+l;
end
end
%casts only

else

for i=l:numFiles
filename=strcat(foldername,'\',char(list.mat(i)));
if (getfield(load(filename, 'IsCast'),'IsCast') &&
-getfield(load(filename,'IsInvalid'), 'IsInvalid'))
x(k)=getfield(load(filename,'LongitudeStart'),'LongitudeStart');
y(k)=getfield(load(filename,'LatitudeStart'),'LatitudeStart');

k=k+l;
end
end
end
%Transpose matrices so that output fits format expected by other programs
x

=x';

y-y';

function

[P]= getParam(foldername,d,Param)

%This function takes in a foldername of CTD files in the current directory
%and returns P, a vector of ordered measurements of the variable specified
%by Param. If d is [1, P contains measured values from point
%measurements only. Otherwise, P contains values from casts only at the
%specified depth.

%Make a list of filenames in the folder to index through
list=what(foldername);
numFiles=length(list.mat);
P=[];
%if

the Param field is not a recognized parameter, exit program

if
(-strcmp(Param,'Salinty')
&&
-strcmp(Param,'Temperature')
&&
-strcmp(Param, 'Specificconductance')
&& ~strcmp (Param,
'Conductivity')
&& strcmp(Param,
'Pressure')
&& strcmp(Param,
'Soundvelocity')
&&
strcmp(Param, 'Density'))
error('The entered parameter is not recognized. Please try again,
using
Salinity,
Temperature,
Specificconductance,
Conductivity,
Pressure, Sound velocity, or Density.');
end
k=l;
%this
is used to keep track of index in P as not every file
necessarily be added to P (depends on cast/ point measurement status)

will

if length(d)==O
%for each point measurement, get the measured value and add it to P
for i=l:numFiles
filename=strcat(foldername,'\',char(list.mat(i)));
if
(getfield(load(filename,'IsPointMeasurement'),'IsPointMeasurement
')
&& -getfield(load(filename,'IsInvalid'), 'IsInvalid'))
P(k)=getfield(load(filename,Param),Param);
k=k+l;
end
end
else
%for each cast, get the measured parameter and add it to P
for i=l:numFiles
filename=strcat(foldername,'\',char(list.mat(i)));
if
(getfield(load(filename,'IsCast'),'IsCast')
~getfield(load(filename,'IsInvalid'),

&&

'IsInvalid'))

%Need to find parameter at depth d
Val= getfield(load(filename,Param),Param);
%Interpolate from measurements to find approximate measurement
%at specified depth
Depths=getfield(load(filename,'Depth'),'Depth');
if d > max(Depths) II d < 0
%If depth is outside range of
depths available, return NaN
P(k)=NaN;
else
P(k) = interpl(Depths,Val,d);
end
k=k+1;
end
end
end

Appendix D: Salinity Measurements from Quonochontaug Pond
Longitude
41.350892
41.351041
41.351316
41.351205
41.351560
41.351722
41.351585
41.351467
41.351499
41.351505
41.351530
41.351634
41.351460
41.351243
41.351329
41.351361
41.351456
41.350892
41.351280
41.351098
41.350896
41.351236
41.351223
41.351340
41.351152
41.349552
41.351226
41.351580
41.350984
41.351296
41.350725
41.349937
41.351043
41.351458
41.351137
41.351139

Latitude
-71.709358
-71.710184
-71.710816
-71.710515
-71.710695
-71.710313
-71.710502
-71.710759
-71.709590
-71.710851
-71.710378
-71.710304
-71.710332
-71.710924
-71.710586
-71.709469
-71.710867
-71.710244
-71.710966
-71.709077
-71.711355
-71.710928
-71.711178
-71.711063
-71.710818
-71.710090
-71.710027
-71.710688
-71.711216
-71.710729
-71.709369
-71.709764
-71.710672
-71.709995
-71.709543
-71.709930

Salinity [PSS]
5.6
12.0
17.9
18.1
19.8
20.0
20.7
21.1
21.2
21.5
21.9
22.0
22.4
22.6
23.1
23.6
24.0
24.1
24.1
24.2
24.2
24.4
24.6
24.7
24.8
24.8
25.1
25.2
25.3
25.6
25.6
25.7
25.7
25.7
25.8
25.9

Longitude
41.350421
41.350695
41.350603
41.350987
41.350352
41.350570
41.351132
41.351463
41.350399
41.351014
41.350333
41.350839
41.350908
41.350940
41.349477
41.351315
41.349301
41.350022
41.351363
41.351083
41.349438
41.351081
41.350716
41.351241
41.349802
41.351200
41.351218
41.351337
41.351361
41.351002
41.350269
41.351189
41.351057
41.351381
41.351178

Latitude
-71.709965
-71.710146
-71.709702
-71.711304
-71.710260
-71.710379
-71.710585
-71.710884
-71.710381
-71.709517
-71.709430
-71.709983
-71.709709
-71.710320
-71.709494
-71.710689
-71.709538
-71.709378
-71.710174
-71.711335
-71.709838
-71.711135
-71.710394
-71.711259
-71.709442
-71.710372
-71.709198
-71.710262
-71.709844
-71.709814
-71.709586
-71.709699
-71.710752
-71.711077
-71.710558

Salinity [PSS]
26.1
26.4
26.4
26.4
26.6
26.6
26.7
26.7
26.8
26.9
27.0
27.0
27.0
27.1
27.2
27.3
27.3
27.4
27.4
27.4
27.5
27.5
27.6
27.6
27.6
27.9
28.5
28.6
28.8
28.8
29.2
31.6
32.3
32.8
34.7

Appendix E: Finding Anomalies in Grayscale Infrared Video with ImageJ
ImageJ is an open-source image processing and analysis program that can be downloaded
from http://rsbweb.nih.gov/ii/index.html. While macros can be written for repetitive processes, in
this case only the standard user interface, as shown in Fig. 42, was needed.

File Edit Image Process Analyze Plugins Window Help

Figure 42: ImageJ User Interface
The investigator opted to watch the TIR video feed and record any anomalous areas
observed by eye rather than write a program to find these abnormalities because the steep
background gradient and subtle differences in pixel intensities made automated anomaly
detection very difficult. Several attempts were made to compensate for the background gradient
and find anomalies with a program, but these proved less capable of catching subtle temperature
differences than the human eye.
ImageJ treats videos as what it refers to as "stacks". A stack is any collection of images, or
"slices", and can be played like a movie. Most operations in ImageJ can either be performed on a
single image within a stack or on the stack as a whole. ImageJ provides several methods of
making stacks either from .avi files or from several different image files. This document will
discuss only .avi files; support for other types of files can be found at the ImageJ website.
Parsing and Compressing the Video Files
Because video files are very large, the first step to processing a video is breaking it in to
manageable sections. In order to allow for larger sections to be opened in ImageJ at a time, one
must increase the maximum memory allocated to the program by opening the Memory window
at Edit > Options > Memory & Threads... The text box labeled "Maximum Memory" should
be changed to the highest value the program allows or that the user is comfortable with. For this
investigation, 5000 MB proved a sufficient amount.
Once the memory has been increased, open the video by clicking on File > Import and then
clicking on the AVI... option. After selecting the video as the file to open, the AVI Reader
window appears as shown in Fig. 43.
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Figure 43: ImageJ AVI Reader
The first time a file is opened, the First and Last Frames will be set to the first and last frame in the
entire video. In processing the TIR from this study, it was found that sections of video approximately
5000 frames long were the largest amount of data ImageJ could handle without getting too slow or
crashing. With a playback rate of 30 Hz for most common videos, this corresponded to roughly two
minutes and 45 seconds of the raw video. When importing the video, be sure to check the box labeled
"Convert to Grayscale".
To save time in reviewing the data, create a subsection using only the first out of every three frames
(or whatever seems reasonable given the frame rate of the raw video at hand). To do this in ImageJ, go to
Image > Stacks > Tools > Make Substack... This will open the "Substack Maker" window, shown in
Fig. 44.

Enter a range (e.g. 2-14), a range with incrementi
(e.g. 1-100-2) or a list (e.g. 7,9,25,27)
Skces:

F Delete slices from original stack

Figure 44: Substack Maker Window

Following the instructions in the window, enter the frames that are to be made into the new
substack. For example, to make a substack containing the first frame out of every three in a video
that is 5000 frames long, one would type 1-5000-3, indicating the starting frame (1), the ending
frame (5000), and the increment at which to take slices (3). When this has been entered, click

Ok. A new window will now open containing the substack. Save this substack as an .avi. Over
the course of processing the video, several other substacks will be made each covering a different
section of the original frames.
It is important that the frames in each subsection can be correlated to the frame in the raw
video so that areas where anomalies are seen can be revisited, so be sure to give the substack a
filename that indicates its contents. For example, the first subsection containing the raw data
from the first 5000 frames might be called frames 1-5000.avi, the second called frames500010000.avi and so on. Since the frame numbers come from the raw data, the file called frames 15000.avi would only contain 1669 frames after having reduced the number of frames by a factor
of three from the stack to the substack. With this system of organization, to find the frame in the
raw data that corresponds to the 1 0 0 th frame in the file frames5000-10000.avi, one would
multiply the frame number (100) by three to compensate for the reduction in frame numbers,
then add 5000, the frame number of the first frame in this file. The 100th frame would therefore
correspond to the 5300 frame in the raw video.
If desired, once several substacks are made they can be concatenated, or combined such that
one substack flows continuously into the next. This is not a necessary step and the decision is left
to the user whether he or she would prefer longer sections of video that are slower to load but
fewer in number or many shorter sections. Substacks are concatenated by opening two substacks
at a time, then choosing the Concatenate option at Image > Stacks > Tools > Concatenate...
At this point the user will be asked which of the two substacks should come first and what the
new combination of the two substacks should be called. Another substack can then be
concatenated onto the end of this concatenated substack and so on as long as free memory space
permits. Be sure to save the concatenated file with a name that allows for correlation with the
frames from the raw data, as previously described.
Watching and Analyzing the Video
Once the video is broken into manageable sections as described above, each section can be
opened and watched in ImageJ. There are several techniques to highlight subtle differences in
pixel colors, the most useful of which have been changing the color of the video and adjusting
the window and level of the video.
Grayscale video is normally shown in 256 gradations ranging from white to black. The
change in color between any of these is very small and difficult to notice. ImageJ offers several
lookup tables (LUTs) that change how the pixel intensities are displayed as colors, as shown in
Fig. 45.
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Figure 45: Examples of different lookup tables (LUT) from ImageJ. Each of the 256
boxes represents the possible pixel intensities; the color of that box shows what color
pixels of that intensity will be displayed as. The upper left is the standard grayscale LUT.
Each box is a different shade ranging from black to white. The upper right has single
colors representing increments of four pixel intensities over the pixels in the image. The
lower left has a color assigned to blocks of eight pixel intensities. The lower right LUT
has groups of 16 pixel intensities displaying as a single color.

The different gradations in color call attention to different details. Depending on the image
at hand, one LUT may be better than the others. In Fig. 46 a single image is shown in original
grayscale and then in each of the LUTs shown in Fig. 45.

Figure 46: A single image shown in grayscale and with each of the lookup tables shown
in Fig. 45. In this image the cove appears to have colder water than the surrounding sea
water. This can be seen in the grayscale image, but it is much easier to see in the colored
images. Note that in this case, fewer color gradations clarify the region exhibiting the
cold area; in other frames in the same video this may not be the case. The pixelated patch
on the right side of the upper right image is due to the background gradient in the image,
not a temperature difference.
LUTs can only be applied to grayscale images. The type of the image may need to be
changed by clicking Image > Type > 8-bit before the LUT may be changed. Standard LUTs
may be selected in ImageJ by opening Image > Lookup Tables... and selecting one of the
various options. A custom LUT may also be created by going to Image > Color > Edit LUT...
The colors may be changed either by clicking on a single box in the LUT and adjusting the red,
green and blue slider bars until the desired color is shown or by clicking and dragging the mouse
to select several boxes, then choosing the initial color and the final color. ImageJ will create a
gradient between those two colors over the selected boxes. Once an LUT is made be sure to save
it using the Save... option in the LUT Editor window. To apply this LUT to future images, click
File > Open and select the LUT file. It will automatically be applied to the open image.

Adjusting the window and level of a frame offers another method of highlighting differences
in the video. When these values are changed the image remains in grayscale, but the scale is
changed. The level is the pixel intensity at the middle of the spectrum displayed. The window is
the range of intensities displayed. Fig. 47 shows the window and level menu within ImageJ.
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Figure 47: Window and level menu in ImageJ. The box displays a histogram of all pixel
intensities in the current frame. In this case, the tall narrow peak on the left is the border,
the middle peak is the water, and the small peak to the right is land. The diagonal line
shows the window and level. The left image shows the default window and level settings.
The right shows settings that have been adjusted to accentuate the range of pixel
intensities covering the water.
The pixels between the ends of the diagonal lines in Fig. 47, also shown as the region
between the red lines (added by the author), will be stretched to cover the entire range from 0 to
255 in the displayed image. All pixels outside of this range will show up as 0 (black) if below the
range or 255 (white) if above the range. The level defines the center of this line. The window
defines the range covered by it. The left image shows the default initial window and level
settings. The level is centered in the middle at 128, and the window is 255, covering the entire
possible spectrum. The values on the right have been adjusted so that it includes only the peak
representing the water. This will stretch differences in the water color, making them easier to
detect. Fig. 48 shows the images with the window and level settings from Fig. 47.

Figure 48: The original image (left) and the image with the window and level adjust as
shown in Fig. 47 to exaggerate pixel differences in the water region. This is another
technique to make anomalies easier to detect in infrared video.
The window and level values are changed in ImageJ by clicking Image > Adjust >
Window/Level... This will open the menu shown in Fig. 47, through which the values can be
changed using the slider bars.
There are many other ways to adjust images through ImageJ, but these two were found the
most useful. Once the appropriate LUT or window and level settings have been chosen, open
each of the video subsections, apply these changes and watch the video. Sometimes it is helpful
to watch the same clip with different settings to make sure all anomalous areas are observed.
Record any interesting frame numbers (displayed at the top of the ImageJ window in which the
video is playing) so they can be referenced back to the original video.

Appendix F: Creating an Overlay from ViewPoint Snapshots in Google Earth
When the subject of a frame or series of frames is identified as an area of interest, it can be
displayed as an overlay in Google Earth as shown in Fig 49.

Figure 49: An area of anomalous temperatures recorded during an aerial TIR imaging
flight displayed as a series of overlays in Google Earth. Google Earth screenshot: © 2012
Europa Technologies, C 2012 Basarsoft, © Google, Image ©2012 DigitalGlobe.
The process of creating these overlays is similar to that discussed in Appendix B for
horizontal profiles made with the CTD. All of the GPS and camera orientation data necessary to
determine the position of the image overlay are contained within the ViewPoint software. Using
the snapshot feature, the .jpeg image to be displayed and the .kml file are exported and saved. A
MATLAB program has been written to remove the border around each frame, process a batch of
snapshots at once, modify the .kml files to include the new image, and display the .kml file in
Google Earth. If this was not done and the .kml files were opened directly as exported from
ViewPoint, the resulting image would appear as shown in Fig. 50 rather than Fig 49. To create an
image overlay as shown in Fig. 49, the program createMosaic is used. The code for this program
is found in Appendix G.

Figure 50: A series of TIR frames opened directly from .kml files exported from
ViewPoint. Running createMosaic makes a new image in color and with adjusted contrast
to highlight subtle differences and makes the border transparent so that the original GPS
coordinates can be used, but the background does not show. Google Earth screenshot:
Image C 2012 DigitalGlobe.
Setting Up and Exporting Images from ViewPoint:
1. Using ViewPoint's playback mode, find the frames to be included in the overlay.
When the video is paused on the frame to be included, type the letter I. Every time
the letter I is pressed, six new files are added to a folder called "snapshots" in the
current playback directory. Only two of these files will be used: the .jpeg file of the
exported image and the .kml file containing a reference to the image and the GPS
coordinates of the four corners. The other files may be deleted.
2. Repeat this for each of the frames to be incorporated in the overlay. Note that not
every single frame in the TIR video needs to be included in the overlay; in fact, too
many frames can distract from the detail in any one of the given frames. For the
mosaic in Fig. 49, one frame was used every two seconds over the course of an 18
second clip.
3. Once all of the frames have been exported, transfer the .jpeg files and .kml files from
the "snapshots" folder into a folder dedicated to the overlay at hand. To make life
easier, put this folder into another folder dedicated to processing TIR data in
MATLAB.

4. Open MATLAB and set the current folder to the folder dedicated to processing TIR
data. Further instructions on how to do this can be found in Appendix B.
5. Create a new script using the D icon or by opening File > New > Script. Copy and
paste all of the code from Appendix G into the new script. If an electronic copy of
Appendix G is not available, type the code into the script exactly as it appears. Save
the new script as createMosaic.m (the file name should default to this) by clicking
File > Save in the MATLAB Editor window.
Running createMosaic
The program createMosaic is called by typing a command of the form

>> createMosaic(datafoldername,newfoldername,transp,lim in, limout, c);

into the command window. The input parameters are defined as follows:
" datafoldername - This is the name of the folder containing the .jpeg and .kml files to be
used in the Google Earth overlay. If this folder is not in the current directory in
MATLAB, the full path must be used rather than just the foldername (i.e.
'C:\Users\Katy\Documents\Thesis\MATLAB\Overlay' rather than just 'Overlay'). As
with other folder and file name inputs, datafoldername must be entered between two
apostrophes to identify it as a string.
*

newfoldername - This is the name of the folder to which the new images and modified
.kml folders will be saved. The same rules apply for entering newfoldername as for
datafoldername. A folder with the name entered as newfoldername must be created prior
to running the program. The same folder could be specified as both datafoldername and
newfoldername. In this case the images will be unaffected, as the modified images are
saved as .png files rather than .jpeg files, but the reference within the .kml files will be
changed to the new .png image rather than the old .jpeg image.

e

transp - This term defines the transparency of the image. It must be a value ranging from
0 (completely transparent) to 1 (completely opaque). If only one frame is to be shown in
the overlay, transp should be 1. However if several frames overlap, the transparency
should be lower to better blend the frames together. In Fig. 49, the transparency was set
to 0.85.

Slimin and limout- These term sand the next are strictly related to adjusting the image
to enhance contrast and make subtle temperatures in the area of interest easier to see.
Both limin and limout are 1 by 2 matrices of the form [min max], where min and max
are numbers between 0 and 1. Together these act as a scaling factor for pixel intensities.
The pixel intensities in a grayscale image range from 0 (black) to 255 (white).. Within the

createMosaic function, the minimum and maximum values given in lim-in are stretched
to match those in lim-out (see Fig. 51).
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Figure 51: The inputs lim in and limout scale the pixel intensities such that pixels in
the original picture with intensities greater than or equal to limin max will have
intensities of limout max in the new image. Pixels with intensities less than or equal to
limin min will be set to limout min in the new image. All other pixels will be scaled to
fall within the range set by limout.
Rather than being on a scale from 0 to 255, the inputs for lim in and lim out are
fractions of the pixel intensity range, i.e. an input of 1 corresponds to a pixel intensity of
255, an input of 0.5 corresponds to a pixel intensity of 127.5, and so on
*

c - This term determines the skew of the pixel intensities in the lim in range in the
limout range. In short, a higher c value results in a darker image, while a lower c value
results in a lighter image. A c value of one results in an unbiased distribution in the
limout range.

By choosing lim in wisely, any land or other unimportant details can be filtered out. The
land is usually of higher pixel intensities than the water, so setting limin max to a value less
than the minimum value of land image intensities will change all of the land in an image to a
solid color with pixel intensity limout max. These inputs can also be used to stretch contrast in
the range of interest to make subtle color differences more noticeable, as shown in Fig. 52.

Figure 52: An image before and after calling imadjust, a built-in MATLAB program,
which scales contrast using Limin and Limout. Note that differences in color in the
water are easier to see while the land has mostly been blotched out.
Note that the new image in Fig. 52 still has some spots in the area showing land where
vegetation results in darker colors. These can be removed by opening the .jpeg file of this image
prior to running createMosaic and using paint or another image processing function to change the
area that is clearly land to white, leaving the border between the land and water as is. Make sure
to save the image under the exact same name after the land has been whited out. This has been
done to the majority of the images used in this report, as shown in Fig. 53. The program will
decide where the land ends and water starts.

Figure 53: An image with the area that is clearly land whited out using paint on the .jpeg
file prior to using createMosaic. This prevents vegetation and other dark spots from
detracting from the important differences in water color. Note that the interface between
land and water has not been altered by hand.

Determining the proper values for limin, limout and c takes some experimenting. In
general limin should represent the lowest and highest pixel intensities in the region of
importance. In this case, limin min and max represent the lowest and highest pixel intensities
observed in the area representing water, with a small buffer zone on either end. Limout and c
determine the color scale of the final image and are best decided by trial and error. For the
images in this study, lim in was [0.2 0.4], lim out was [0 0.5], and c ranged from 0.5 to 2,
depending on the brightness of the picture. To determine what the best values are without
creating a full mosaic, save a sample picture in the current folder in MATLAB and type the
following into the command window:

>>rgb = imread('pic.jpeg');
>> gray = rgb2gray(rgb);
>> I = imadjust(gray, lim in, limout, c);
>> imshow(I,jet);

In this case 'pic.jpeg' will need to be replaced by the name to which the sample image is
saved, and limin, limout, and c will need to be set as desired. The last two lines can be
repeated as many times as necessary, changing lim in, limout, and c, until the resulting image
is satisfactory. Note that an odd glitch in MATLAB can sometimes lead to the image appearing
solid blocks of red, green and blue. This has only been noticed the first time the code is used, or
when the figure window is not already open when the code is run; if this happens, try leaving the
figure window open and typing

>> imshow(gray);
>> imshow(I,jet);

This generally fixes the problem. If the MATLAB figure program is left open for the remainder
of the session, the problem should not recur.
Once all of the .jpeg (with whited-out land if desired) and .kml files exported from
ViewPoint are in a single folder and the appropriate limin, limout and c values have been
determined, open Google Earth. If Google Earth is not open prior to running createMosaic, it will
open while the program runs on its own, but it may crash due to attempting to open files within
Google Earth before it has fully started. A delay has been written in to createMosaic; every time
a .kml file opens it will pause 0.5 seconds. This results in a lengthy run time if many files are
being opened, but is necessary to keep Google Earth from crashing.
Now call createMosaic. The image in Fig. 49 was created by typing the following line into
the MATLAB command window:

>>createMosaic('Polis','Polis-processed',0.85,

[0.2

0.4],[0

0.5],

2.5);

The folders 'Polis' and 'Polis processed were created prior to running the code and were
both contained in the folder devoted to processing ViewPoint files. 'Polis' contained the .jpeg
and .kml files exported from ViewPoint; 'Polisprocessed' was an empty folder prior to running
the code, and afterwards had a .png image and a .kml file for every one of the images and .kml
files in 'Polis'. Before running the code, the .jpeg files in 'Polis' were opened in Paint and the
areas that were without a question land were whited-out, as previously described.
By typing that one line, the entire mosaic is opened automatically. A snipping tool or screen
shot can be used to save the image in a format accessible to other programs.

Appendix G: MATLAB Code for createMosaic Program
function []
limout,c)

= createMosaic(datafoldername,newfoldername, transp, limin,

% Takes all .jpeg images in datafoldername, adjusts the contrast as defined
% by limin, limout, and c, makes the border transparent and the image a
% transparency defined by transp, and gives them color, then saves them as
% .png folders in newfoldername.
%
%
%
%

Changes the image reference in the corresponding .kml file to the new
.png file, saves the .kml file in new foldername (or replaces the .kml
file if newfoldername is the same as datafoldername), then opens all .kml
files in Google Earth.

% Warning: Open Google Earth prior to running code. Failure to do so could
% cause Google Earth to crash.
% If images come out all red, this is likely due to a glitch within MATLAB.
% Try leaving a MATLAB figure window open and using the lines:
% I = imread('anyPictureFileName.jpeg');
% J =

rgb2gray(I);

% imshow(J);
% imshow(J,jet);
%
%
%
%
%
%
%

Where 'anyPictureFileName.jpeg' is replaced by an actual picture file
name in the current directory. Calling imshow(J) should show the
grayscale image, and then imshow(J,jet) should show the same image in
color. If this is the case, the problem is solved, and createMosaic
should function properly. DO NOT CLOSE ANY FIGURE WINDOWS IN THE MIDDLE
OF, BEFORE, OR AFTER RUNNING THIS PROGRAM. This will likely cause the
problem to return.

% Find the number of files in the data folder and create a list of their
% names
= dir(fullfile(datafoldername,'*.jpeg'));
= dir(fullfile(datafoldername, '*.kml'));

listPics
listKmls

numFiles = length(listPics);
newFileName='';

DOMnode =[];
% Set all of the pixels in the border area to completely transparent. All
% other pixels are set to a transparency value transp.
alphadata = zeros(480,640);
for i=18:449
for

j

=

67:590

alphadata(i,j)=transp;
end
end

% For each file:
% a) edit the image and save the new image to the destination folder.
% b) change the image reference in the .kml file to the new image, then
%
save the .kml file in the new folder.
% c) open the .kml file.
for i=l:numFiles
filename=listPics(i).name;
rgb = imread(fullfile(datafoldername,filename));
%tell MATLAB that image is grayscale, not rgb
gray = rgb2gray(rgb);

%adjust contrast based on lim in, lim out, c
J=imadjust(gray,lim in,lim out,c);
% Convert adjusted grayscale image to an rgb image using the colormap
% jet (scale from blue to red rather than black to white).
I = ind2rgb(J,jet);

% Save new image
newPicName = strrep(filename,'.jpeg', '.png');
imwrite (I, [newfoldername '\'
newPicName],'Alpha',alphadata);
% Open .kml file and extract structure
kmlName=listKmls(i).name;
DOMnode = xmlread(fullfile(datafoldername,kmlName));
% Identify image reference and change it to the new picture file name
hrefElement = DOMnode.getElementsByTagName('href').item(O);
hrefElement.getFirstChild.setData(newPicName);
% Save the new .kml file in the new folder.
kmlName],DOMnode);
xmlwrite ([newfoldername '\'
%Open the .kml file in Google Earth (this line may cause problems in
%Macs. It can be removed and the files opened by hand if necessary.
kmlName]);
winopen([newfoldername '\'
% Wait 0.5 seconds to give Google Earth a chance to load the image
pause(0.5);
end

Appendix H: Creating a Google Earth Overlay for Any Image Using MATLAB
A modification of createMosaic has been written for when a program other than ViewPoint
is used to work with aerial TIR or when an overlay is desired from a different type of image.
This program does no image processing and only handles a single image at a time. These
functionalities can be added in if desired. The code is heavily dependent on the XML Document
Object Module. No understanding of this is needed to use the program or to make small changes,
but should more knowledge be needed, documentation can be found in the JavaTM Package
org.w3c.dom Description at
http://docs.oracle.com/javase/6/docs/api/org/w3c/dom/package-summary.html
The program createOverlay is called by typing the following in to the MATLAB command
window:

>> createOverlay(PicFileName, coords);

Only two inputs are required:
0

PicFileName - this is the filename of the image to be overlaid. As with all other
filenames in matlab, it must be a string (enclosed by apostrophes). If the picture is in the
current directory, only the name of the picture is necessary; otherwise the full location of
the file on the hard drive is needed. PicFileName should include the file extension (i.e.
.jpeg, .png, .tif, etc).

*

Cords - this is a matrix containing the latitude and longitude of the four coordinates of
the image's corners. It is a 4 by 2 matrix where the first column is the latitudinal
coordinates and the second column is longitudinal coordinates, all in decimal form. The
rows start with the bottom left corner of the image and go counterclockwise, as shown in
Fig. 54.
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Figure 54. Format of cords input for createOverlay function. The latitudinal coordinates
go in the first column of cords and the longitudinal coordinates in the second. The rows
start at the bottom left corner of the image and go counter clockwise. These coordinates
can define any sort of a quadrilateral on the map; the image will automatically be rotated
and transformed to fit them. Note: image intentionally left as a blank representation of the
image to be overlaid.

The program createOverlay makes a .kml file with the same name as the image file input.
This file can then be opened either by typing

>> winopen ( 'FileName. kml');

in the MATLAB command window or by opening the file on the hard drive. Opening the
file by clicking on it in MATLAB will only show the source code.
As stated previously, createOverlay does nothing to process the image and only handles one
image at a time. It is intended to be changed or incorporated into a larger program as necessary
to suit the needs of the project at hand.
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Appendix I: Creating a Google Earth Image Overlay Using MATLAB
function

[]

= createOverlay(PicFileName, Coords)

% Writes kml file that can be opened in google earth, displaying picture
% at picFileName at the given Coords.
%Coords must be a 4x2 matrix where the first column are the latitudinal
%coordinates (in decimal form) and the second column are the longitudinal
%coodinates. The first row describes the location of the lower left corner
%of the picture, second describes lower right, third describes upper right,
%and fourth describes upper left.
% Create a string defining the name of the
Name = textscan(PicFileName,
FileName = Name{l};

kmlFileName =

.kml file from PicFileName

'%[^.]');

[FileName '.kml'];

% Change GPS coordinates into format expected by .kml file
format long;
coordStr = [num2str(Coords(l,l),8) ',' num2str(Coords(1,2),8) '
num2str(Coords(2,1),8) ',' num2str(Coords(2,2),8) ' ' num2str(Coords(3,1),8)
',' num2str(Coords(3,2),8) ' ' num2str(Coords(4,1),8) ','

num2str(Coords(4,2),8)];

% Create Node (this is xml-type coding setting up the structure for the
% .kml file)
docNode = com.mathworks.xml.XMLUtils.createDocument('kml');
kml = docNode.getDocumentElement;
%Necessary attributes for all .kml files:
kml.setAttribute('xmlns','http://www.opengis.net/kml/2.2');
kml.setAttribute('xmlns:gx', 'http://www.google.com/kml/ext/2.2');
overlay = docNode.createElement('GroundOverlay');
% Creates name of overlay. 'Google Earth Image Overlay' may be changed as
% desired.
name = docNode.createElement('name');
name.appendChild(docNode.createTextNode ('Google Earth Image Overlay'));
overlay.appendChild(name);
%Description of overlay. PicFileName may be changed as desired.
descript = docNode.createElement('description');
descript.appendChild(docNode.createTextNode (PicFileName));
overlay.appendChild(descript);
image = docNode.createElement('Icon');
% This reference points to the image to be displayed.
href = docNode.createElement('href');
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href.appendChild(docNode.createTextNode(picFileName));
image.appendChild(href);
overlay.appendChild(image);
%Format shape of image, give GPS coordinates.
quad = docNode.createElement('gx:LatLonQuad');
coords = docNode.createElement('coordinates');
coords.appendChild(docNode.createTextNode(coordStr));
quad.appendChild(coords);
overlay.appendChild(quad);
kml.appendChild(overlay);
%save the new .kml file
xmlwrite(kmlFileName, docNode);
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